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About CallPilot

This chapter introduces CallPilot, the powerful multimedia messaging syste
from Nortel Networks. CallPilot offers a single solution for managing many 
types of information, including voice mail, fax-mail, e-mail, telephone calls, 
conferencing, calendars, directories, and call logs. 

CallPilot enables you to get all the information you need from one source, 
whether through display-based telephone sets, your wireless set, your Win
desktop computer, a speech recognition interface, or another personal 
communications device. 

In this chapter 
About this guide 13

Finding your way around CallPilot 35
VPIM Networking Implementation and Administration Guide 11
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Overview

Introduction
The VPIM Networking Implementation and Administration Guide provides 
detailed instructions for implementing VPIM Networking.

Assumptions
This guide assumes that the Meridian Application Server has been correctl
installed and is operational. If the application has not been installed, then in
it before proceeding. For installation instructions, refer to the hardware 
installation guide appropriate to your server type.

If the server has been installed but is not operational, refer to the Maintenance 
and Diagnostics Guide for information on troubleshooting your system.
14 CallPilot
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Skills you need

Introduction
You need certain skills and knowledge to use this guide effectively.

Nortel Networks product knowledge
Knowledge of, or experience with, the following Nortel Networks products w
assist you:

■ Meridian 1

■ Meridian Mail

PC experience or knowledge
Knowledge of, or experience with, the following PC products will be of 
assistance. This guide does not document the following functionality:

■ Microsoft Windows NT

■ Microsoft Windows 95

Other experience or knowledge
Other types of experience or knowledge that may be of use include the 
following:

■ network management

■ client-server systems

■ flowcharting
VPIM Networking Implementation and Administration Guide 15
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Related information products

Introduction
Following is a list of all CallPilot technical documents. The CD-ROM that yo
receive with your system contains these guides, enabling you to search the 
suite of documentation online. If you prefer, you can print out entire guides,
parts of a guide. 

You order copies of these documents using the NTP numbers or P0 numbe
provided. 

Planning and migration
These guides are used before CallPilot is installed to help you plan your sy
and, if you have a Meridian Mail system, migrate to CallPilot. 

Installation guides
These guides describe how to install server hardware and CallPilot softwar

Document Title NTP number

Planning and Engineering Guide 555-7101-101

Meridian Mail to CallPilot Migration Guide 555-7101-801

Document Title

NTP number
or
P0 number

Meridian Application Server 200i Installation Guide P0884895

Meridian Application Server 702t Installation and 
Maintenance Guide

P0884909

Meridian Application Server 1001rp Installation and 
Maintenance Guide

P0886776

Software Installation Guide 555-7101-200
16 CallPilot
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Administration and feature guides
These guides describe how to configure CallPilot, administer and maintain 
and use its features. 

Networking guides
These guides describe how to plan, install, set up, and troubleshoot networ
services. 

Document Title NTP number

Basic Administration Guide 555-7101-300

Advanced Administration Guide - 
volume 1

555-7101-301

Advanced Administration Guide - 
volume 2

555-7101-301

Reporter Guide 555-7101-310

Application Builder Guide 555-7101-325

Document Title NTP number

Networking Planning Guide 555-7101-100

NMS Implementation and Administration Guide 555-7101-302

AMIS Networking Implementation and Administration 
Guide

555-7101-303

Enterprise Networking Implementation and 
Administration Guide

555-7101-304

Integrated AMIS Networking Implementation and 
Administration Guide

555-7101-305

VPIM Networking Implementation and Administration 
Guide

555-7101-306
VPIM Networking Implementation and Administration Guide 17
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Maintenance and troubleshooting guides
These guides describe how to maintain your system once it is in service and
you troubleshoot operational problems.  

End user guides
These guides are intended for end users of CallPilot, such as telephone se
and desktop messaging users. 

CD ROM
The CD-ROM contains all the listed documents, except the end user guides

Document Title NTP number

Maintenance and Diagnostics Guide 555-7101-500

Support Tools Guide 555-7101-800

Document Title P0 number

Speech Activated Messaging User Guide P0886127

Multimedia Messaging Quick Reference Card P0886128

Multimedia Messaging User Guide P0886140

Desktop Messaging for Microsoft Exchange Guide P0886141

Desktop Messaging for Lotus Notes Guide P0886142

Internet Messaging Guide P0886143

Document Title Order number

CallPilot Technical Documentation CD NTRG19AA

A0742811
18 CallPilot
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Using the online reference guides

Introduction
The online reference guides contain the same procedures and context-sen
information that you find in the online Help. However, the guides contain 
additional information not included in the online Help. These guides have 
overview sections that describe concepts and features and provide other 
CallPilot information.

To print an online guide, see Printing an online guide on page 26.

The online guides
The following reference guides are available online.

■ Overview Guide

■ Advanced Administration Guide

■ Application Builder Guide

■ Reporter Guide

■ Networking guides

● Networking Planning Guide

● AMIS Networking Implementation and Administration Guide

● Integrated AMIS Networking Implementation and Administration Gu

● Enterprise Networking Implementation and Administration Guide

● VPIM Networking Implementation and Administration Guide

● NMS Implementation and Administration Guide
VPIM Networking Implementation and Administration Guide 19
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To access the online guides

1 On the Help menu, click Reference Guides.

Attention:  If you see the following error message, Adobe Acrobat was not 
installed during the MAS software installation. Refer to the Software 
Installation Guide for the Acrobat Installation procedure.
20 CallPilot
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2 Click the document you want to open.

Result: The front cover is displayed. Select a chapter from the front cover 
or from the bookmarks displayed in the left frame.

Navigating the online guides
There are several ways to navigate through the guides and to find specific to 
VPIM Networking Implementation and Administration Guide 21
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Bookmarks
Bookmarks are displayed on the left-hand side of each document. To go to
specific part of the document, such as a chapter or section, click the bookm
 

Using hypertext links
Once you find the chapter or section you are interested in, use hypertext lin
navigate within the chapter and document.
22 CallPilot
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Links appear as blue underlined text.
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When you click a link, the selected topic is displayed.

Using the document button bar
The online guides have a button bar at the top of each page to help you ge
around quickly. 
24 CallPilot
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On each page you can use the following buttons:  

Using Acrobat Reader commands
Adobe Acrobat Reader also has features to help you work through the docum
You can learn more about Reader by accessing its online guide from the Ac
Reader Help menu.

Here are some of the more common commands:

Button Description

home Goes to the cover page of the current guide.

help Provides tips on how to use the online guides.

contents Goes to the table of contents for the current guide.

index Goes to the index for the current guide.

back Goes to the previous page in the guide.

next Goes to the next page in the guide.

 Function Description

. Goes back to the last view and forward to the next view

. Goes to the previous page and to the next page in the 
document.

. Goes to the first page of the document and to the last pa
of the document.
VPIM Networking Implementation and Administration Guide 25
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Searching for information
You can use the Acrobat Search tool to find specific information. This tool 
enables you to find all instances of a word or phrase. You can search eithe
current guide or all the online guides.  

Printing an online guide
For best results when you print an online guide, use a Postscript-compatibl
printer capable of 600 dpi output. If a Postscript printer is not available, use
Adobe Acrobat 3.0 (not Acrobat 3.01). Acrobat 3.0 is installed by default wi
the CallPilot X.X Administration client software. It is also available from http
www.adobe.com.

To set print properties for an online guide

1 In Acrobat Reader, open the file for the online guide.

2 From the File menu, select Print Setup...

Search function Description

. 

Searches the current document for all instances of the 
word or phrase you type. Goes to the first page that has
least one instance of the word or phrase, and highlights
your choice.

. 

Searches all the online guides for the word or phrase yo
type. Displays a list of the guides containing the search
word or phrase. The guide you select opens to the first 
page that has at least one instance of the word or phras
and highlights your choice.

. 

Goes to the next instance of the word or phrase.

. 

Goes to the previous instance of the word or phrase.
26 CallPilot
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3 In the Print Setup dialog box, select Properties.

4 Select the Graphics tab.

5 Select Resolution, and then select 600 dpi.

6 Click OK until you exit from all the dialog boxes.

Note: Your screens should print out legibly, even on a non-Postscript 
printer.

To print an online guide

1 From the File menu, select Print.

2 Indicate the page range.

3 Click OK.
VPIM Networking Implementation and Administration Guide 27
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Contacting technical support

Introduction
Contact your distributor’s technical support organization to get help with 
troubleshooting your system.

Before contacting Technical Support, ensure that you have the necessary 
information on hand.

Information about your server
Technical Support may ask for the following information, which is displayed
the Server Settings window: 

■ server version number

■ release number

■ serial number (if you have this number available)

Getting there  Nortel SMI > Meridian Application Server > System 
Administration

To view server settings

1 Double-click System Configuration.

2 Double-click Server Settings.

Identifying Field Replacement Units (FRUs)
If you have diagnosed a hardware problem and need to order a replacemen
you must be able to identify the part.

For more information about running diagnostics on hardware components a
identifying field replacement units, see the Maintenance and Diagnostics Guide.
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Contacting Nortel Networks
If you have comments or suggestions for improving CallPilot and its 
documentation, Nortel Networks would like to hear from you. Please see th
following address:

http://www.nortelnetworks.com/callpilot_feedback
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How this guide is organized

Introduction
The VPIM Networking Implementation and Administration Guide is organized 
in the sequence of tasks required to successfully implement VPIM Network
for CallPilot. Start at the beginning of the guide and work your way through
until all required tasks are completed.

Contents
This guide contains the following chapters.

Chapter title Description

Chapter 1, About CallPilot This chapter describes how to work with the
CallPilot interface and how to use this guide

Chapter 2, Getting started This chapter provides an overview of VPIM 
Networking.

This chapter describes the features support
by VPIM Networking and how VPIM 
Networking works.

This chapter also provides a high-level 
overview of the tasks that are performed 
during implementation.

Chapter 3, Gathering information This chapter explains how to gather the 
information required to implement VPIM 
Networking.

Chapter 4, Configuring CallPilot for 
VPIM Networking

This chapter describes how to configure 
CallPilot for VPIM Networking.

This chapter describes every box that must b
completed and provides detailed procedures
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Chapter 5, Adding sites to VPIM 
Networking

This chapter describes how to configure the
local site. This chapter also describes how t
add and configure every site in the messagin
network that uses VPIM Networking to 
exchange messages with local site.

This chapter describes every box that must b
completed and provides detailed procedures

Chapter 6, Testing and backing up VPIM 
Networking

This chapter describes how to test the 
implementation of VPIM Networking to 
ensure that it is properly configured. This 
chapter also describes how to perform a 
backup of the system.

Chapter 7, Maintaining VPIM 
Networking

This chapter explains how to perform both 
regularly scheduled maintenance tasks and
as-required maintenance tasks.

Chapter 8, Troubleshooting VPIM 
Networking

This chapter provides information to identify
and solve problems with VPIM Networking.

AppendixA, VPIM conformance This appendix shows how VPIM Networking
conforms to the VPIM profile.

Chapter title Description
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Conventions

Introduction
This guide uses the following conventions.

How commands are documented in procedures
As with many Windows applications, there are several different ways to exe
a command. For example, to copy text, you can choose any of the following
methods:

■ Choose Copy from the Edit menu.

■ Click the Copy button on the toolbar.

■ Type the keyboard shortcut Control + C.

The procedures in this guide document only the first method, choosing a 
command from a menu.

Navigation information in procedures: Getting there
Procedures in this guide are preceded by a Getting there statement. This 
statement summarizes the steps you take to navigate to the window or tab w
the procedure is carried out.

All Getting there statements start at the Nortel SMI window. This assumes 
have logged on and selected the appropriate system. Each item mentioned
that represents an icon, window, or tab that makes up the path to the final 
destination. 

Example
To define special mailboxes such as the broadcast mailbox, you must be o
Mailboxes tab. The Getting there statement for this procedure is as follows:

Getting there  Nortel SMI > Meridian Application Server > CallPilot > Messaging 
Administration
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After you double-click Messaging Administration, the property sheet display
You then click the Mailboxes tab.
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Finding your way around CallPilot

In this section
Connecting to CallPilot 36

Multi-administrator access 44

Error handling in property sheets 46

Using the online Help 49
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Connecting to CallPilot

Introduction
To perform administrative tasks, or to build or work with CallPilot application
you must first connect to the name of server (the MAS server). The MAT 
Navigator and the System Management Interface (SMI) work together to gi
you access to your system and sites.

Selecting a system—the MAT Navigator
The first step in logging in is to launch the MAT Navigator, which has its ow
password. The MAT Navigator connects your administration client to the M
server. It displays all your sites and systems and enables you to select one
work on.
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Selecting a program—the System Management Interface (SMI)
When you select a system from the MAT Navigator, you are prompted for a
second password. At this point, the SMI window for the selected system or 
displays. 
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The SMI gives you quick and easy access to your system or sites. The SMI
a navigation tree to display the system’s hierarchy. In the tree, icons repres
the folders and programs. Double-click a folder icon to view its contents. 
Folders can contain programs and other folders. Double-click a program ico
run the associated program. 

Selecting an object—list views
When you launch certain programs, the first thing you see is a list view. The
view displays all the objects of a certain type (such as mailbox classes) tha
currently defined in the system. The list view includes predefined objects as
as those defined by an administrator. From the list view window, you can se
a specific object to work on.

Viewing and changing properties
Select an object and display its properties by 

■ double-clicking it or 

■ single-clicking it and selecting Properties from the File menu

■ right-clicking it and selecting Properties from the popup menu
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Entering data and choosing options—property sheets
A property sheet is displayed when you view an object selected from a list v
Certain programs, such as Messaging Administration, display a property sh
immediately after launching. Property sheets have one or more tabs. Each 
has fields, referred to as boxes, in which you can type data or from which y
can select options. 
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Most CallPilot property sheets look like the following:
 

40 CallPilot



November 1998 About CallPilot 

n the 
ociated 
 the 

 in. 
Some property sheets are divided into two panes. When a box is checked i
left pane, the selected capabilities are enabled and you can access the ass
tabs. Select a tab by clicking its name in the left pane or by clicking the tab in
right pane. These property sheets look like this:
 

Mandatory boxes
If the name of a box is underlined, the box is mandatory, and you must fill it
You cannot save if any mandatory boxes are empty.
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Common buttons
The following buttons appear on most property sheets: 

Using the toolbar buttons
For easier access, some of the more common tasks, such as Print and Sav
represented as buttons on the toolbar. 

The following buttons are used throughout CallPilot. Buttons or icons specifi
certain CallPilot functions, such as backups and archives, are documented 
relevant chapters.

Button Description

Save Saves all changes made on any of the tabs in a property s
and closes the property sheet. Therefore, save only when y
have made the necessary changes on all tabs.

Cancel Closes the property sheet without saving any changes.

Print Prints the contents of all tabs in the property sheet.

Help Displays Help for the current tab. From this overview Help 
topic, you can access other Help topics, the index, and the
search function.

Toolbar button Description

. 

Saves any changes you have made and then transfers 
the application’s data to the server.

. 

Opens the Print dialog box and prints the active file or th
objects you specify.

. 

Deletes the object you select.
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Displays the properties of the object you select.

. 

Displays the Help topics window.

. 

Explains the next menu item or screen object you click. 
a window, there is an arrow. On tabs or in dialog boxes
there is no arrow.

. 

Opens the New dialog box, where you identify the 
properties of the object you are creating. The button loo
different in different applications.

. 

Displays the Open dialog box, where you select an obje
to open. The button is different in different applications.

. 

Reloads the current page and displays the changes you
have made.

. 

Enables you to select how the system displays icons.

Toolbar button Description
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Multi-administrator access

Introduction
You can create multiple administrator accounts to make administering CallP
easier and more efficient. Multiple accounts enable administration 
responsibilities to be distributed among a number of people. Therefore, cer
administrators can specialize in certain tasks, such as maintaining users, 
performing backups, analyzing reports, or creating multimedia services. 

Access classes
For security reasons, administrators should be given access only to those pa
the system that relate to their role. For example, an administrator who is 
responsible only for creating multimedia services should have access only 
Application Builder and the Service Directory Number Table. 

Each administrator account is assigned an access class. An access class i
of the parts of the system and the level of access allowed. The access leve
as follows:

■ create/delete (enables an administrator to delete objects such as users
services)

■ edit

■ view

■ none

For example, an administrator may be able to create or delete objects in 
Application Builder but only view User Templates.

Simultaneous access
Multiple administrators can log in to CallPilot at the same time without 
overwriting other work.

If you are the first to log in to a particular resource, such as a specific mailb
class or user profile, and another administrator tries to access the same res
a dialog box appears to inform you of the other administrator. At this point, 
can do one of the following:
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■ Keep editing.

■ Save your changes, and release the resource to the other administrato

■ Cancel your changes, and release the resource to the other administra

If you do not respond to this prompt within two minutes—because you are a
from the terminal, for example—the system releases the resource so that o
can access it. If this happens, all your unsaved changes are lost.

An administrator who accesses a resource that is currently being edited se
read-only view of the property sheet in which all boxes are dimmed. This 
indicates that the resource is currently locked. The administrator is not notif
when the resource is released, but must try to access the property sheet ag
see whether its status has changed. 

If a user tries to log on to a mailbox while an administrator is changing the 
profile, the user is unable to log on and receives a message that says the m
is in use.

Refreshing screens
Because multiple administrators can access the same database at the sam
a Refresh command is available from the View menu to ensure that the view
are seeing is the most up-to-date. 

For example, if you are viewing a list of users when another administrator 
deletes a user, the only way to see the change is to refresh the screen. You
should, therefore, refresh the screen regularly.
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Error handling in property sheets

Introduction
If you make certain types of errors while entering data, you are not able to s
your changes until you correct the errors. For example, if you leave a mand
box empty, you receive a message prompting you to fix it. 

Note: These errors do not show up in the Event Browser or Alarm Monitor 
because the errors relate only to data entry and are not operational problem

How error handling works
There are two types of error messages.

Type 1
If you get this type of error message, click OK, and then fix the problem 
described in the message before you try to save again.
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Type 2
If you get this type of error message, click OK to see a list of errors.

Double-click an error from the list. Your cursor is automatically placed in the
box where the error was made so that you can correct it. 
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For example, if you double-click the second error, the Remote notification ta
displayed, with the cursor in the Target number box. 
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Using the online Help

Introduction
While administering or maintaining CallPilot, you may have questions about
purpose of certain boxes and buttons, or need more information about 
completing certain tasks. 

Online Help provides brief answers to the questions “What’s this?” and “Ho
do I...?”

Context-sensitive Help
If you need to know the purpose of a particular box or button, use context-
sensitive Help.
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To access context-sensitive Help

1 Click the  icon in a window or the  icon on a tab or in a dialog 
box.

2 Point to the box or button for which you want more information, and click.

Result: A pop-up description of the selected object is displayed.
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Procedures
If you need to know how to do something, you can access procedures to le
you through a task. 

High-level tasks
In some cases, high-level tasks take you through longer procedures. These
also provide you with navigation to the step-by-step procedures they includ
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About CallPilot  Standard 1.0

. The 
ithin 
n 
res.

 

For example, setting up Delivery to Telephone requires several procedures
high-level task summarizes these procedures. You click the gray buttons w
the task to open the step-by-step procedures. The high-level task remains o
your screen so that you can continue to use it to move through the procedu

Overviews
Overview topics provide brief descriptions of tabs, features, and the tasks 
carried out from the tabs. However, the online guides contain more detailed
feature descriptions.

To access overview topics

Click the Help button on a tab.
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To find information in Help
You can look up procedures and overview topics in the following ways: 

1 From the Help menu, select Help Topics.

Note: You can also press F1 on the keyboard.

2 Go to one of the following tabs: 

■ To see the table of contents of all the Help topics, select the Contents 
tab.

■ To look up a subject alphabetically, select the Index tab.

■ To do a full-text search to find topics that contain the words you enter, 
select the Find tab.
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Getting started

VPIM Networking is one of the networking solutions offered by CallPilot. Th
chapter introduces VPIM Networking. It covers basic concepts and terminol
that are useful for understanding VPIM Networking.

This chapter also provides a basic overview of the VPIM Networking 
implementation process.

In this chapter
About VPIM Networking 57

Data networks 79

Security 97

Implementing VPIM Networking 103
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About VPIM Networking

In this section
Overview 58

Intranets and the Internet 60

How VPIM Networking works 61

Send VPIM Networking messages to other sites 64

Receive VPIM Networking messages 68

VPIM Networking benefits 69

CallPilot and VPIM Networking 70

VPIM Networking connectivity 74

VPIM Networking and other networking solutions 76
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Overview

Introduction
VPIM Networking is one of the networking solutions offered by CallPilot.

You must be familiar with the basic concepts of messaging networks, data 
networks, and protocols. To review these concepts, consult the Networking 
Planning Guide.

Definition: VPIM Networking
VPIM Networking offers the ability to exchange voice, fax, and text messag
with other users over a Transport Control Protocol/Internet Protocol (TCP/IP
data network.

Messages can be exchanged with users at integrated sites, which are part o
private messaging network, as well as with users who are at open, VPIM-
compliant sites.

Standard
VPIM Networking uses Simple Message Transfer Protocol (SMTP) and 
Multipurpose Internet Mail Extensions (MIME) in compliance with the Voice
Profile for Internet Mail (VPIM) standard.

Data networks
VPIM Networking uses existing data networks, not switch networks, to 
transport messages. The data network must support the TCP/IP protocol.

There are too many possible data network setups to be documented here. 
Therefore, this guide provides an overview of some of the most common se
Working with your data network administrator, you will be able to determine
how VPIM Networking is implemented on the existing data network.
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Note, however, that VPIM Networking may require minor modifications to th
existing configuration of the data network.

Messaging to open sites
The ability to exchange messages with open sites is inherent in VPIM 
Networking. That is, if you have VPIM Networking implemented on your loc
site, local users can exchange messages not only with other sites within the
private messaging network, but also with users at open sites.

Key terms
The following terms are used throughout this guide:

ATTENTION! VPIM Networking is an incremental implementation on 
your existing data network. This guide assumes that yo
will work closely with the administrator of your data 
network to implement VPIM Networking.

Term Definition

Open ■ Not defined in the network database

■ Not part of the private messaging network, in mos
cases

Integrated ■ Defined in the network database

■ Part of the private messaging network

Data network 
administrator

■ Individual responsible for  implementing and 
maintaining the data network at the local site
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Intranets and the Internet

Introduction
An organization can exchange messages exclusively over an intranet, or th
Internet, or a combination of the two. The way an organization exchanges 
messages determines how VPIM Networking is implemented.

Definition: Internet
The Internet is a global web of interconnected computer network—a networ
networks. It provides the basis for global electronic mail (e-mail) and 
information exchange over the World Wide Web, as well as other services.

Definition: Intranet
An intranet is an internal, private data network. It is accessible only to 
authorized internal users.

Intranets are usually connected to the Internet.

The Internet consists of a number of local networks and intranets that are 
interconnected with gateways. These gateways sometimes have physical 
connections or ports that provide access to networks.

The purpose of a gateway is to accept all traffic that is intended for a specif
destination and to pass along, or route, any traffic that is not intended for th
destination.
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How VPIM Networking works

Introduction
This basic overview provides some of the conceptual information you need
implementation. This overview also provides detailed information necessar
understand VPIM shortcuts.

VPIM address
A VPIM address is the address format used by VPIM Networking. A VPIM 
address is similar in form to an e-mail address.

For example, to send an e-mail message to a user over the Internet, you en
two-part address. The left-hand side of the address contains a unique ident
for the user, often the user’s name. The right-hand side of the address is th
domain name of the user, the system on the data network that handles mes
For example:

■ username@company.com

VPIM addresses also have two parts. However, the left-hand side usually 
contains the user’s public switch telephone network (PSTN) number. The ri
hand side is the domain name. For example:

■ 14165977070@company.com

VPIM address restrictions
Some restrictions apply to VPIM addresses.

Left-hand side

■ can contain numeric characters only

■ maximum length of 128 characters

Right-hand side

■ is case-sensitive

■ maximum length of 255 characters
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Note: The VPIM specification allows for different forms on the left-hand side
a VPIM address, including alphabetic characters, but numeric characters a
recommended. However, VPIM Networking requires numeric characters on
left-hand side.

The VPIM specification allows for alphanumeric characters on the right-han
side. CallPilot supports alphanumeric characters on the right-hand side.

VPIM message
A VPIM message consists of two parts:

■ a message header

■ a message body that consists of voice, fax, and text parts

● all message parts are MIME-encoded

Encoding parts
VPIM voice messaging parts are encoded using the ITU’s G.726 32 kbps 
ADPCM standard.

VPIM text parts are not encoded.

VPIM fax messaging parts are encoded based on the tagged image file form
Class F (TIFF-F) specification. 

Note: A fax must be in TIFF-F. When saving faxes, be aware of subtypes (th
are many besides Class F). Not all subtypes are fax-compatible. All TIFF fil
no matter what the subtype is, have a TIF extension.

Message header
VPIM Networking messages are addressed with the following format: left-
hand_side@right-hand_side. This format is used by CallPilot for both the T
and From: entries of a message header.

For example, the To: and From: entries in a typical VPIM Networking mess
header might be

■ To: 12046679000@anothercompany.com

■ From: 15739921000@thiscompany.com

This header information is critical to VPIM Networking, because the header
used to route a message to its destination and to identify the sender.
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CallPilot creates the complete To: and From: entries for users. This is 
convenient for telephone users, who don’t have to enter the complete, long
VPIM address. It is also a way of ensuring the accuracy of the address 
information.

Desktop and telephone users
VPIM Networking is available to both desktop users and telephone users.

Using a keyboard, a desktop user can easily enter the alphanumeric VPIM 
addresses, including the alphanumeric right-hand side for open VPIM sites

However, a telephone user cannot enter the alphanumeric right-hand side o
VPIM address using the telephone keypad and is restricted to numeric addre
Therefore, CallPilot offers alternative ways for telephone users to address V
Networking messages, one for messages to integrated sites and one for me
to open sites.

Telephone users are, however, still limited to a numeric left-hand side. 
Telephone users can hear the alphanumeric right-hand side.

Note: The distinction between desktop users and telephone users is importa
this guide. When using VPIM Networking, some actions are available only t
desktop users or to telephone users. Some configuration steps apply only t
type of user or the other.

Whenever specified, note the distinction between desktop user and telepho
user. When the term user appears in this guide, there is no distinction betwee
the desktop user and the telephone user.
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Send VPIM Networking messages to other 
sites

Introduction
VPIM Networking supports the exchange of messages with both open sites
integrated sites.

Definition: Open site
An open site is usually not part of the private messaging network. It can be
VPIM-compliant system.

Definition: Integrated site
An integrated site is part of the private messaging network and is defined in
network database.
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Example
In the following diagram, the private messaging network consists of three 
integrated sites. All three use VPIM Networking to exchange messages with
another. Site 3 is also configured so that telephone users can exchange me
with open sites over the Internet. Desktop users at all three sites can excha
messages with open sites without any special configuration.

Send messages to open and integrated sites
To understand how VPIM Networking works, you must be familiar with the 
basic differences between messages sent to open sites and those sent to 
integrated sites.

Open sites
Telephone users and desktop users have different ways of addressing mes
to recipients at open sites.

Telephone users
If a telephone user wants to send a message to an open site, the open site m
defined in the local network database as an open VPIM shortcut. An open V
shortcut identifies the PSTN number of the open site to the domain name o
open site. An open VPIM shortcut is used to form outgoing VPIM addresse
only.

G101150.ep

Private Messaging Network

Site 1
Head office

Site 3
Research and
development

Site 2
Branch office

Open site
Business Partner
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For example, Gwendolyn Zwnatsky wants to compose and send a messag
user at an open site. She knows the recipient’s VPIM address: 
12044541000@bigcompany.com

To send a message to this open site using a telephone, the list of open VPI
shortcuts should include an entry such as the following:

■ 1204454 = bigcompany.com

Gwendolyn gets the PSTN telephone number and the open shortcut from th
network administrator. When Gwendolyn sends a message to this open site
must enter 15 1204454 1000, where

■ 15 is the VPIM compose prefix

■ 1204454 is the VPIM open shortcut

● 1 is the country code

● 204 is the area code

● 454 is the area/city code

■ 1000 is the mailbox number

CallPilot uses this information to identify that the message is being sent wit
VPIM Networking. It finds the shortcut in the network database and maps it 
domain name. CallPilot creates the following To: header from this informati

■ To: 12044541000@bigcompany.com

Desktop users
To send a message to an open site, a desktop user does not require an VP
open shortcut to be defined in the network database.

A desktop user can address a message to any open site user without restri
and can use either a VPIM open shortcut or a VPIM address.

Integrated sites
Integrated sites are part of your private messaging network. Information ab
all integrated sites that exchange messages with your local site is defined in
local network database.

This information includes VPIM networking shortcuts. These shortcuts are t
various ways that local users can address users at the remote site.
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Distinction between open and network shortcuts
VPIM open shortcuts and SMTP/VPIM network shortcuts have very differen
roles. The open shortcuts provide the alphanumeric domain name required
the right-hand side of a VPIM address.

The network shortcuts provide alternative ways for local users to address 
messages to users at remote sites. Instead of always entering the left-hand
of the VPIM address, users can enter the same numbers that they use to di
site. The right-hand side is supplied by the fully qualified domain name (FQD
for the site contained in the network database.

Creating the From: header
When a local user sends a VPIM Networking message to an open or integr
site, the message header contains a From: entry.

The From: entry enables the recipient to reply to the sender.

The From: entry normally consists of the PSTN address and the domain na
For example:

■ 14165979999@branch.thiscompany.com

The left-hand side of the address is created from the PSTN address for the
site. The right-hand side is the fully qualified domain name of the local site’
mail server. This FQDN is defined in the local network database and is add
the outbound address automatically.
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Receive VPIM Networking messages

Introduction
The way your local system receives inbound VPIM Networking messages 
depends on how your data network is set up and whether the messages ar
coming from the Internet or an intranet.

CallPilot continuously monitors TCP port 25 for incoming SMTP information

If a message is received successfully
If a message is received successfully, the message and addresses are con
to their native format and the message is delivered to the local mailboxes.

If the message is not received successfully
If there is a problem during the message transfer session, the local system
an event. The event log indicates the address of the sending system.

If the session is successful but the message is not delivered to a local mailb
non-delivery notification (NDN) is generated and sent to the message send

There are several reasons why a message might be successfully received 
undeliverable to a local mailbox. For example, the mailbox does not exist.

Receive messages over the Internet
If VPIM Networking messages are sent over the Internet, a mail relay is 
probably used to receive all incoming messages destined for the VPIM sys
on an intranet.

The mail relay receives all incoming SMTP mail and redirects VPIM messa
to the appropriate CallPilot server.

There are two ways for a mail server to identify the appropriate server:

■ using mail exchange (MX) records in the domain name server (DNS)

■ using the right-hand side FQDN of the To: address
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VPIM Networking benefits

Introduction
VPIM Networking offers many benefits, including

■ a cost-effective standard for exchanging messages over TCP/IP data 
networks

■ wide vendor support

■ substantial economic benefits over analog networking

● no long-distance toll charges for messages

● no competition with Call Answering and Voice Mail traffic for channe
capacity

Feature highlights
VPIM Networking introduces several new features to CallPilot networking. I
has the ability to do the following:

■ Operate over standard TCP/IP networks (Internet/intranet).

■ Make better use of existing data networks.

■ Save long-distance toll charges for network messages by sending them
the Internet.

■ Exchange messages with other third-party VPIM-compliant systems.

■ Exchange messages with fax and text, as well as voice.

■ Exchange messages with other Nortel VPIM-compliant systems: Norst
Voice Mail and Meridian Mail Net Gateway.
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CallPilot and VPIM Networking

VPIM Networking features
The following table lists the CallPilot features that are supported by VPIM 
Networking:

CallPilot feature Supported Notes

Call Sender Yes To integrated sites only.

Can be used for both call answering and 
composed messages from network users i

■ the calling line identification (CLID) is 
present in the message, or

■ the mailbox numbering plan follows the 
dialing plan, or

■ a remote user entry is added for the 
network user

Names Across the Network No This feature is currently not supported.

Name Addressing Yes

Personal Distribution Lists Yes

Shared Distribution Lists Yes

Multiple Recipients Yes Recipients to non-VPIM sites are not 
included in the VPIM message.

Reply To Sender Yes

Reply All Yes

User’s Actual Personal 
Verification

No

Administrator-Recorded 
Personal Verification

Yes
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Remote Site Spoken 
Names

Yes To integrated VPIM sites only.

Private Tag Yes Messages tagged as private are announc
to the recipient. A message tagged as 
private may be forwarded.

Acknowledgment Tag Yes Acknowledgment tags result in a messag
to the sender indicating that the message 
was actually listened to.

Urgent Tag Yes Messages tagged as urgent trigger urgen
related features, such as Remote 
Notification or Message Waiting Indication.
Urgent messages are given priority for 
transmission as determined by the 
scheduling parameters.

Economy Tag Yes Messages tagged as economy are sent w
a “low” importance information tag.

Received Time Announced Yes A certified tagged message is 
acknowledged when the message is read, 
not received.

Sent Time Announced Yes Sent time is converted to the recipient’s 
local time zone and is expressed in local 
time.

120-Minute Messages Yes Length is restricted only by memory 
available on the mail server.

Sender’s Name (Text) Yes Only supported if American English 
character set (ASCII 32-126).

Recipient’s Name (Text) Yes Only supported if American English 
character set (ASCII 32-126).

Message Subject (Text) Yes Only supported if American English 
character set (ASCII 32-126).

CallPilot feature Supported Notes
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Non-delivery notifications
A non-delivery notification (NDN) is generated if an error occurs during an 
attempt to deliver a message. There are three types of non-delivery notifica

■ local: generated by the local sending system

■ network: generated by the remote receiving system

■ intermediate: generated by systems involved in routing message

Note: If VPIM Networking messages are sent over the Internet, there is no 
guarantee of when users receive non-delivery notifications. Internet servers
take up to several days before sending a non-delivery notification.

Free-form text non-delivery notifications
The non-delivery notifications for VPIM messages are actually generated by
delivery status notification (DSN) facility of mail relays and proxies. Most m
relays and proxies generate the correct DSN, which results in a properly 
formatted non-delivery notification.

However, some older mail relays and proxies generate incorrect DSNs. The
result in NDNs that are free-form text messages.

Although formatted differently from the standard non-delivery notification, a
free-form text non-delivery notification can be read and understood by desk
users.

If a user has a voice-only mailbox, the user never receives a free-form text 
delivery notification and receives no notification at all.

Multimedia messages and non-delivery notifications
If a multimedia message is sent to a user who does not have the mailbox 
capabilities to accept one or more parts of the message, the entire messag
rejected.

Sender’s Department No

Timed Delivery Yes

CallPilot feature Supported Notes
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For example, if a voice message with a text attachment is sent to a user wi
voice mailbox only, the entire message is rejected and the sender receives 
delivery notification.

Message delivery notification
A message delivery notification (MDN) is generated if a user requests one 
before sending a message. This request is made by tagging the message f
acknowledgment. With VPIM Networking, a message delivery notification 
indicates that the recipient has opened at least one part of a message.

The following must also be considered:

■ The receiving system may be configured to not send message delivery
notifications. If so, local users cannot tell if their messages were never 
delivered or never read by recipients on the receiving system.

■ Meridian Mail Net Gateway does not support message delivery 
notifications. Local users cannot tell if a recipient at a Net Gateway site
read the message.

Although CallPilot supports message delivery notification, even messages 
exchanged between two CallPilot systems may not be entirely supported. F
example, if a message is routed through any system that does not support 
message delivery notifications, the message delivery notifications are lost.

OM reports
Operational Measurement (OM) reports for cumulative network activity to a
particular site are available for VPIM Networking. 

OM reports for individual messages are not generated for VPIM Networking
Since VPIM messages do not incur long-distance toll charges, it is not nece
to track each message for the purposes of bill-back.

See also
For detailed information about CallPilot features consult the Advanced 
Administration Guide.
VPIM Networking Implementation and Administration Guide 73



Getting started  Standard 1.0

ct to 

 

em as 

t, 

g.

 are 

ocol 
VPIM Networking connectivity

Connectivity
Because it uses an industry-standard protocol, VPIM Networking can conne
many other systems, including

■ other CallPilot systems (Release 1 or later)

■ Norstar Voice Mail (Release 3 or later)

■ Meridian Mail systems (Release 11 or later) through Meridian Mail Net
Gateway (Release 1 or later) (which acts as an IP-to-circuit-switched 
network gateway)

■ VPIM-compliant systems from other vendors

Connectivity with open and integrated sites
These systems can be included in the local VPIM Networking database as 
integrated remote sites.

If these systems are not integrated, local users can still send messages to th
open sites.

VPIM-compliant systems from other vendors
To determine if a messaging system from another vendor is VPIM-complian
refer to the system’s documentation.

All VPIM-compliant systems can exchange messages with VPIM Networkin

Restrictions
Although VPIM Networking exchanges messages with these systems, there
some important restrictions to consider when setting up VPIM Networking.

Meridian Mail Net Gateway
Meridian Mail Net Gateway takes Meridian Mail messages sent using the 
Enterprise protocol, an analog protocol, and converts them into a digital prot
so that they can be sent across an IP network.
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Messages exchanged between a site using VPIM Networking and a site us
Net Gateway can contain only voice components, not text or fax.

Third-party systems
Although VPIM Networking uses the industry-standard VPIM protocol and c
exchange messages with third-party systems from other vendors, there ma
special restrictions.

Consult the documentation of the third-party system to determine if there ar
any special configuration considerations or any restrictions in functionality. 
Confirm the capabilities enabled at a third-party site.

See also
For a review of VPIM conformance specifications, consult AppendixA, VPIM 
conformance.
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VPIM Networking and other networking 
solutions

CallPilot networking solutions
CallPilot offers several networking solutions, enabling you to create a netwo
that is best suited to your needs.

VPIM Networking can be implemented in a network that uses a variety of 
messaging solutions and protocols for communication.

Multimedia support
VPIM Networking offers the fullest support for different media in the messa
body parts.

Comparison with Enterprise Networking
Almost all CallPilot messaging features that are available with Enterprise 
Networking are also available with VPIM Networking.

Currently, the only feature offered by Enterprise Networking that is not 
available with VPIM Networking is Names Across the Network, which enab
the automatic creation of temporary remote users.

Networking 
solution

Voice 
only Fax only Voice and fax

Voice, fax, 
and text

Enterprise 
Networking

Yes No No No

AMIS Networking Yes No No No

VPIM Networking Yes Yes Transmits all 
voice and fax 
message body parts

Transmits all voice, 
fax, and text message
body parts
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Comparison with AMIS Networking
Like AMIS Networking, VPIM Networking enables you to extend your 
messaging network beyond your private network. Both networking solutions
industry-standard protocols. They are designed to work with all other messa
systems, regardless of vendor, as long as the systems use the same protoc

Like AMIS Networking, VPIM Networking supports exchanging messages w
integrated remote sites and open remote sites.

The following table compares VPIM Networking and AMIS Networking:
. 

VPIM Networking AMIS Networking

Incurs Internet/intranet toll rates Incurs standard PSTN toll rates

Uses digital file transfer Uses audio playback

Unaffected by line Is susceptible to noise

Uses LAN port Uses voice ports

Supports voice messages Supports voice messages

Supports fax messages Does not support fax messages

Supports text messages Does not support text messages

Supports urgent message tags Offers partial support for urgent 
message tags

Supports certified message tags Offers partial support for certified 
message tags

Supports private message tags Does not support private message 

Sends messages to open sites Sends messages to open sites
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Data network setup

Introduction
How VPIM Networking works and how it must be configured depends, in pa
on how the data network is set up.

There is no single setup for data networks. Therefore, you must work with t
data network administrator to understand how VPIM Networking should be 
implemented.

Connected to Internet
If your data network is connected to the Internet, there are many possible 
hardware and software setups. 

In most instances, incoming VPIM Networking messages pass through a 
firewall, which helps to protect the security of your network. Messages that 
allowed through the firewall are passed to a mail relay or a proxy server.
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Outgoing VPIM Networking messages are sent either to a mail server or to
proxy server. Outgoing messages usually pass through a firewall before ent
the Internet.

Within an intranet
If your organization sends messages over an intranet and is not connected
Internet, there are different configurations for the data network.

CallPilot server

Desktop client Desktop client

MX records
or LHS lookup

Ougoing SMTP
mail/proxy server

Firewall/Proxy Mail ServerOROR Firewall/ProxyMail Relay

Internet

Firewall/Proxy

G101161.eps

Incoming Outgoing
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The Internet and intranets
Most data networks are configured to use a combination of the Internet and
intranets. Combinations are supported by VPIM Networking.
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Message treatment

Introduction
VPIM Networking treats incoming and outgoing messages in different ways

Note: This section describes some of the inner workings of the SMTP/VPIM
data network and their relationship to VPIM Networking. This section may b
most relevant to the data network administrator.

Incoming messages
How CallPilot treats an incoming VPIM Networking message depends on th
system configuration. The following examples explain how an incoming 
message is treated when it comes from an intranet and when it comes from
Internet.

Intranet
When an incoming message comes from an intranet, there is a direct SMTP
VPIM connection between two systems.

The system continuously monitors TCP port 25 for an incoming SMTP/VPIM
message. When the system detects an incoming message, it uses the SMT
protocol to receive the message, including recipient information.

If the message is received successfully, the message is converted into the 
CallPilot format. The address is converted to native representation and is 
delivered to the local mailbox of the recipient.

If an error occurs during the session, the receiving system logs an event th
includes the address of the sending system. The sending system generally 
sending the message several times.

If the delivery to a local mailbox fails for any reason, such as the mailbox do
not support the fax content contained in the message, a non-delivery notific
is generated and sent to the sender.
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Internet
When an incoming message comes from the Internet, a mail relay may be 
to receive all incoming SMTP mail and to redirect the message to the 
appropriate CallPilot server. There are two ways to indicate the appropriate
CallPilot server to the mail relay:

■ DNS MX record lookup The CallPilot server must be configured as the 
least preferred MX record in the DNS server.

■ Left-hand side (LHS) resolution Using the left-hand side of the SMTP 
message recipient address, the mail server redirects the message to th
appropriate CallPilot system, which hosts the mailbox of the recipient.

Example: Using the appropriate database or table lookup, the mail serv
maps the left-hand side, 14165551234, from the address 
14165551234@acme.com to an internal host, pixie.acme.com.

Relationship of the server FQDN to VPIM shortcuts
There are two possible origins of an inbound message:

■ an integrated site that is part of your messaging network

■ an implicit open site, which is not part of your messaging network but i
known and is listed in the open VPIM shortcuts, or an unknown open s
which is not part of your messaging network and is not included in the o
VPIM shortcuts. To CallPilot, these are indistinguishable.

Message from an integrated site
The following examples are based on this message:

● From: 16135558877@chilly.org

● To: 14165551234@realcool.org

If the sender of the message is located at an integrated site in your messag
network, the sender is presented as an integrated site to the recipient.

This assumes that when VPIM Networking was implemented at the receivin
site (realcool), the following were configured for the remote site (chilly):

● server location: Chilly Branch Office

● server FQDN: chilly.org

● VPIM shortcut: 1613555 (overlap: 0)
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The left-hand side of the incoming message is matched against the VPIM 
shortcut. This identifies the message sender as a user at Chilly Branch Offi

The address is converted to an internal format designating the remote site 
the sender’s mailbox number (8877). For example, using a telephone to ret
the message, the recipient hears an announcement similar to the following:
“Message 1 from Mailbox 8877 at Chilly Branch Office.”

Similarly, a user at realcool can compose to a chilly recipient by using the 
dialing plan format as configured in the messaging network configuration. F
example, a user enters 63318877, where 633 is the ESN prefix for the chilly
The message is sent to 16135558877@chilly.org using the network 
configuration information for the site to make up the address.

Message from an implicit open site
An implicit open site is one that is known and is included in the list of open 
VPIM shortcuts.

In this example, the open VPIM shortcut list includes the following entry:

● VPIM shortcut: 1613555

● FQDN: chilly.org

The address is converted to an internal format. For example, when using a
telephone to retrieve the message, the recipient hears an announcement s
to the following: “Message 1, from 16135558877 at open network location 
chilly.org.” The address is spelled out in full (“c-h-i-l-l-y dot o-r-g”).

Message from an unknown open site
When an incoming message is from an unknown open site, nothing in your
configuration identifies the source.

Reply features and VPIM addresses
When a user receives a VPIM message from an open site, the Reply To an
Reply All features can be used. The system handles the reply and the user
not enter an address manually. Therefore, an alphanumeric VPIM address 
not affect the Reply features.
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Outgoing messages
VPIM Networking handles outgoing messages according to their intended 
destination.

The following is an outline of the treatment of an outgoing message:

■ The user composes a message using either a telephone or a desktop.

■ The user enters the address of the recipient, either a VPIM open shortc
a VPIM network address.

■ CallPilot converts the message from the native CallPilot format to MIM
format.

■ The user’s From: address in the MIME format is created using

● a VPIM shortcut of the sender’s location

● the sender’s mailbox

● the local server FQDN

■ If the message is addressed to an integrated recipient, the recipient’s 
address is created using

● the VPIM shortcut of the recipient’s location

● the recipient’s mailbox

● the FQDN of the server on which the recipient resides

■ If the message is addressed to an open recipient, the recipient’s addre
stored in the native message in the correct format (for example, 
124165971234@open_site.com) and is copied into the MIME format 
message.

■ The message is sent from the local system to the destination. If the mes
is sent to more than one destination, the message is sent once for eac
remote server. The message is sent using one of the following:

● by direct connection

● by mail server (using an MX record)

● by the outgoing SMTP/mail proxy server

Outgoing mail and proxy servers
The outgoing SMTP/mail proxy server only deals with outbound messages.
system first attempts to resolve the FQDN in the To: header locally. If the 
system locates the intended mail system locally (for example, in the DNS ta
it delivers the message.
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If the To: header is not resolved locally, the system assumes that the addre
an Internet address and sends the message to the proxy server. The proxy
takes responsibility for routing the message to the Internet.

Outgoing mail and gateways
A message that is leaving the local site can pass through a gateway. The ga
may alter parts of the address to protect internal server names.

For example, a gateway can convert serv1.ca.company.com to company.co
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TCP/IP

Introduction
VPIM Networking uses the Transport Control Protocol/Internet Protocol (TC
IP). Only TCP/IP data networks are supported.

The CallPilot server, on which VPIM Networking resides, is connected direc
to your existing TCP/IP data network.

Definition: TCP/IP
TCP/IP is the most commonly used transport for data networks. TCP/IP is a
driver that enables computers to communicate with one another regardless
their platforms. This standard is used globally.

The connections that form the basis of the Internet are based on 
TCP/IP.

Definition: TCP
Transport Control Protocol (TCP) is the transport layer of TCP/IP. It ensure
that the information transmission is both reliable and verifiable.

TCP breaks the information into smaller portions. Each portion receives a 
header, which is used to route the packet to its proper destination. A portion
data and its header are know as a packet or a datagram.

TCP passes the packet, with its header, to the IP protocol, which routes the
packet to the correct destination.

Definition: IP
Internet Protocol (IP) is the network layer of TCP/IP. It ensures that the 
information is transmitted from its source to its destination.

To transmit the packets created by TCP, IP routes them.

When IP receives packets from TCP, IP adds another header to the packet
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TCP/IP routing
Routing in a TCP/IP data network relies on IP addresses.

IP addresses
Each computer on a TCP/IP network is identified by its address. The source
destination addresses used by IP have a specific format.

An IP address is a 32-bit number represented by a four-part decimal numbe
(n.n.n.n). Each part, known as an octet, contains 8 bits of the address. Each
has an assigned number between 1 and 254.

Example: 45.211.100.58

Subnetting an IP address
For many organizations, one physical network is impractical, so they have t
or more physical networks. Instead of getting additional IP addresses for ea
physical network, the networks are assigned subdivided portions of the orig
IP address. This is called subnetting an IP address.

Subnetting provides many advantages. One of the most important is that, to
outside world, the organization has a single IP address.

This means there is one direct connection to the Internet. All subnetted phy
networks gain access to the Internet through this connection.

Fully qualified domain names
An IP address is difficult to remember and enter. While the computers on th
TCP/IP network use IP addresses, end-users use fully qualified domain nam
(FQDNs).

A fully qualified domain name is made up of two parts:

■ domain name

■ host name

Domain name
A domain name is interpreted from right to left. For example, in the domain
name acme.com, .com is the top-level domain for commercial sites, and ac
a domain within the .com domain. 
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Host name
A domain contains many computers. Each computer in a domain is a host w
name.

A fully qualified domain name (FQDN) combines the name of a host, a dot, 
the domain name. For example, test.example.com.

Domain name system
The domain name system (DNS) is a naming protocol used with the TCP/IP
protocol. It enables the use of names, instead of IP addresses, to route mes
The DNS provides a domain name to IP address mapping, or translation.

This mapping takes place on a name server, frequently called the domain n
system (DNS) server.

A network of DNS servers works cooperatively. If one DNS server does not
know how to translate a particular domain name, it passes the name on to 
another DNS server.

Need for DNS server
To communicate over the Internet, every physical network requires a DNS 
server. Many organizations own and maintain their own DNS server. Other
organizations, especially smaller ones, may rely on an Internet service prov
(ISP) for a DNS server.

If you do not exchange messages over the Internet, but only over an intran
your network may or may not include a DNS server.

DNS lookup tables
A DNS server contains a lookup table that translates FQDNs into IP addres
This table is defined and maintained by the data network administrator. The
table is also automatically propagated by the DNS server.

A DNS lookup table can store different types of records, including

■ mail exchange records (MX records)

■ address records (A records)
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DNS servers and MX records
The DNS server contains many types of records, including mail exchange (
records.

MX records point to the mail servers that are configured to receive mail sen
the domain name. They describe where SMTP mail for the domain should b
sent.

MX records are useful because they enable you to redirect mail for any hos
domain to any other host or domain. This means that, while your organizati
might use many mail servers, all mail can be sent to the same domain nam

For example, all mail is sent to user@company.com, even though there is n
host called company.com. The MX records redirect the mail to a system tha
accepts mail. This separation of mail delivery and physical hosts is an effici
way of ensuring that the addresses of all users in your organization are com
and easy to remember.

Many data networks have more than one mail server. You can specify the o
of preference. Mail is deposited at the first server in the list. If the mail is no
intended for that server, it is passed to the next server. 

Every host that receives mail should have an MX record. The MX record 
contains a preference value that is the order that a mail server should follow
when attempting to deliver messages. The preference value provides some
tolerance in your mail setup.

MX records and mail servers
If you want to use mail exchange servers within your domain, create specif
MX records for each of the mail servers in your domain. If you use MX reco
assign VPIM Networking the last, or least preferred, MX resource record in
list.

Your domain can have multiple MX records, such as the following:

■ acme.com mail.acme.com   MX 0   mail.acme.com

■ acme.com mail2.acme.com   MX 10   mail2.acme.com

■ acme.com mail.is.net   MX 100   mail3.acme.com

In this case, mail delivery is attempted to mail.acme.com first, because it ha
lowest preference value. If delivery fails, mail delivery is attempted to 
mail2.acme.com.
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MX records and user accounts
MX records provide routing for destination systems. They do not provide 
routing for individual user accounts. End-user routing may be provided by a
mail server, for example.

DNS server setup
The DNS server should be properly set up and the database should be pro
filled before you implement VPIM Networking. However, you will have to ad
one or more records to the database.

One record is for the server, which is entered as part of the CallPilot installa
and is not specific to VPIM Networking.

As an option, you can add MX records if they are being used.
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TCP/IP protocols

Introduction
VPIM Networking uses the TCP/IP protocol to exchange messages over da
networks.

TCP/IP is actually a family of protocols that are often called application 
protocols. These application protocols are based on TCP/IP, but are specia
for particular purposes.

Industry-standard protocols
VPIM Networking uses the following TCP/IP application protocols:

■ Simple Message Transfer Protocol (SMTP)

■ Extended Simple Mail Transfer Protocol (ESMTP)

■ Multipurpose Internet Mail Extensions (MIME)

SMTP, ESMTP, and MIME are industry-standard application protocols. A 
standard describes an interface between components of different vendors, 
is fundamental to the concept of networking.

By using only industry-standard protocols for VPIM Networking, CallPilot 
offers universal compatibility and state-of-the-art technology.

SMTP and ESMTP
SMTP is a way to move e-mail from server to server on a TCP/IP network. M
e-mail systems that send mail over the Internet use SMTP to send message
messages are retrieved with an e-mail client using either Post Office Protoc
(POP) or Internet Mail Access Protocol, version 4 (IMAP4).

In general, SMTP is also used to send messages from a mail client to a ma
server. For this reason, when you configure an e-mail application, both the 
or IMAP server and the SMTP server must be specified.

ESMTP offers several enhancements to SMTP, including machine-readabl
non-delivery notifications.
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MIME
Although TCP/IP is capable of 8-bit binary data transfer, SMTP allows for o
7-bit data transfer.

This means that, to be exchanged over a data network, voice, fax, and sim
text messages must be encoded into a 7-bit representation and encapsulat
a format that can be broken into packets consisting of message headers an

This encoding and encapsulation is done by another application protocol, 
MIME.

Definition
The Multipurpose Internet Mail Extension (MIME) is a specification for 
formatting non-ASCII messages so that they can be transmitted over the 
Internet. MIME enables multimedia e-mail messages containing graphics, a
video, and text to be sent. MIME also supports messages written in other 
character sets besides ASCII.

VPIM
VPIM is a profile that conforms to specifications.

VPIM Messaging uses the ESMTP/MIME application protocols in complian
with industry-standard specifications. These specifications are known 
collectively as VPIM.

Definition
VPIM is a new standard that provides detailed conformance rules for the us
Internet mail for voice mail messaging systems.

With the development of voice messaging, a class of special-purpose comp
has evolved to provide voice messaging services. These computers genera
interface to a telephone switch and provide call answering and voice messa
services.

Traditionally, messages sent to a computer at a remote site were transporte
using analog protocols based on dual-tone multifrequency (DTMF) signalin
and analog voice playback. As the demand for networking increased, there w
need for a standard high-quality protocol to connect analog protocols. To 
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address this need, the VPIM Work Group of the Electronic Messaging 
Association (EMA) has developed the VPIM profile of the Internet standard
MIME and ESMTP protocols for use as a digital voice messaging networkin
protocol.

Implications
Because VPIM is an industry standard, VPIM Networking can exchange 
messages with all VPIM-compliant systems from other vendors. 

Nortel Networks and VPIM
Nortel Networks is playing a leading role in the development of VPIM. Norte
Networks chaired the VPIM Work Group of the Electronic Messaging 
Association (EMA), an inter-industry forum dedicated to developing secure 
messaging technologies.

RFCs
VPIM was turned over to the Internet Engineering Task Force (IETF) of the
Network Information Center (NIC), which continues to produce a series of 
documents that contain protocol and model descriptions. All Internet-standa
protocols are written up in these documents, known as Requests for Comm
(RFCs). 

VPIM Networking is designed to fulfil the requirements specified in RFC 24
on VPIM Version 2 (September 1998).

VPIM compliance
RFC 2421 describes, in detail, how messages are formatted.

To be considered VPIM-compliant, a messaging system must implement al
mandatory features of VPIM in two areas: content and transport. In addition
systems that are VPIM-compliant must not send messages with features be
the standard unless explicit per-destination configuration of these enhanced
features is provided.

VPIM Networking is VPIM-compliant and can exchange messages with all 
other VPIM-compliant messaging systems, regardless of vendor.

For a point-by-point review of how VPIM Networking complies with the 
standard, consult AppendixA, VPIM conformance.
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See also
For additional information on VPIM, visit the official VPIM website:

■ http://www.ema.org
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Security

In this section
VPIM Networking security 98

Firewalls 99

Other security features 100

Message encryption 102
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VPIM Networking security

Introduction
Security and message integrity are major concerns for users sending mess
over the Internet.

When a private data network is connected to the Internet, the Internet beco
almost an extension of the private network. This poses several security conc
especially keeping unauthorized users from accessing your network and 
ensuring that messages are not tampered with during transport.

Existing security
VPIM Networking makes use of the existing security features of your data 
network. If it is connected to the Internet, your network probably uses some
all of the following:

■ firewall

■ packet filters

■ proxy servers and application gateways

These are standard security features for a TCP/IP network.

Discuss security concerns
Many configurations provide the correct security for a particular system. 
Discuss all security issues with the data network administrator.

ATTENTION! The following information is intended as an overview 
only. For detailed information on how to secure your 
system, consult your data network administrator or a 
security specialist.
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Firewalls

Introduction
If your messaging network sends messages over the Internet, your data ne
should be protected by a firewall.

This guide assumes that if your local data network is connected to the Intern
firewall is already in place.

The following discussion is an overview of how a firewall works with CallPilo
For information on how to configure the firewall to secure your network, cons
your data network administrator.

Definition: Firewall
A firewall is a mechanism—consisting of hardware, software, or both—that
protects your network from other users on the Internet. Many firewalls are 
independent devices, while others reside on existing machines.

A firewall controls who can access information behind it and how they can 
access it. The firewall determines the relationship between users within the
firewall and those outside of it.

All traffic into a private data network must go through the firewall. All traffic 
from the private data network into the public data network must also go thro
the firewall. Each message is examined, and those that do not meet specifi
security criteria are blocked.
VPIM Networking Implementation and Administration Guide 99
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Other security features

Introduction
In addition to a firewall, your data network may use other standard security
features, such as packet filters, proxy servers, and application gateways.

Packet filter
A packet filter, also known as a screening router, limits TCP packet traffic to
and from hosts on your network. Packet filters usually consist of both hardw
and software components. You set the limits that a packet filter uses.

In most instances, a packet filter is a stand-alone router. All messages trav
to and from hosts on your network go through the router. Software that con
the limits you have established restricts traffic flow.

A packet filter uses the information in the TCP packet header. The packet f
checks the source and destination addresses and compares them to your l

You can limit all traffic to only packets that you want. For example, if you wa
your network to exchange messages only with your branch office, you can 
your packet filter to accept only these messages.

Proxy server and application gateway
Proxy servers and application gateways provide another level of security fo
your network.  

Definition: Proxy server
The proxy server performs duties for other computers on the network.

A proxy server separates an intranet behind a firewall. A proxy server often
on the firewall. At its simplest, the proxy server allows users Internet acces
from a secured LAN.

A proxy server intercepts all messages entering and leaving a network. 

A proxy server also effectively hides true network addresses. Remote users
messages to the proxy server, which then passes the messages to their int
recipients.
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Definition: Application gateway
An application gateway is the host computer that runs the proxy server. 
Application gateways offer the following services:

■ authenticating and logging usage

■ hiding the internal system names—only the name of the application 
gateway is visible to the outside world

■ simplifying the programming of the packet filter—less complicated 
filtering rules are required, and only traffic destined for the application 
gateway is filtered and all other traffic is rejected
VPIM Networking Implementation and Administration Guide 101
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Message encryption

Introduction
Message encryption is a special type of security feature.

Definition
Message encryption provides a way to send encoded messages from one s
another in a form that only the two sites can understand.

VPIM Networking and encryption
VPIM Networking on CallPilot does not support any encryption applications

Connecting to Net Gateway sites
Meridian Mail Net Gateway optionally supports Entrust encryption between 
Gateway sites. Although CallPilot can exchange messages with Net Gatew
sites, it does not support encrypted messages.

Messages originating from other sites that are encrypted with Entrust will b
rejected by a CallPilot VPIM Networking site. A non-delivery notification is 
returned to the sender of the message.

CallPilot appears to Net Gateway as a generic VPIM-compliant site. Net 
Gateway will not send encrypted messages to CallPilot systems.
102 CallPilot



November 1998 Getting started 
Implementing VPIM Networking

In this section
Overview 104

Planning and engineering considerations 109
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Overview

Introduction
Successful implementation of VPIM Networking requires planning and 
preparation. A plan that specifies the objectives and functionality of the 
implementation is important.

Before you begin to implement VPIM Networking, you should understand th
basic implementation process and what you are expected to do.

Implementation scenarios
There are many ways to implement VPIM Networking. The implementation
depends on the connections established among the CallPilot system, other
in the messaging network, and other sites to which you want to send mess

Whether or not your site uses mail relays, proxy servers, and firewalls, as we
how they are configured, affects the implementation of VPIM Networking.

Therefore, there is no one standard procedure for implementing VPIM. This
overview presents several typical implementations that vary in complexity. Y
system is probably similar to one of them.

Before you begin
Implementing VPIM Networking is an incremental activity. The following 
assumptions are made:

■ A private, server-based data network, including all necessary security 
devices, is already in place. This network must support the TCP/IP 
protocol.

■ The name of server, on which CallPilot runs, is installed, tested, and 
connected to the data network.

ATTENTION! This section is intended as an overview only. It is 
assumed that you will work with your data network 
administrator to set up VPIM Networking.
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■ CallPilot is installed and tested (except for VPIM Networking), and 
mailboxes are configured.

■ The switch is installed and configured.

■ If implemented on the local site, Network Message Service (NMS) is fu
implemented.

■ If local desktop users use Internet Mail Access Protocol (IMAP) clients
IMAP is fully configured and tested.

■ Contact has been made with the network administrators of the remote 

Data network is set up
VPIM Networking uses your private data network. 

Your Simple Message Transport Protocol (SMTP) message network is 
configured for your unique needs and may vary in complexity from other 
networks. 

VPIM Networking interacts with one or more of the following systems:

■ Domain Name System (DNS) server

■ SMTP e-mail proxy server (or gateway, or relay)

Configuration and management of these systems is at your discretion. The 
following overview is intended as a basic guideline only.

DNS server
The names of VPIM Networking remote sites are entered into the network 
database during VPIM Networking implementation. These names must be 
resolvable to IP addresses by VPIM Networking’s SMTP delivery agent usi
the Windows NT system network sockets facilities on the MAS server.

The MAS server may be configured to use a local host name table or, more
likely, to use an external DNS. This server must be able to resolve, in 
cooperation with other DNS servers, all of the network site names entered i
database.

In the event that an intervening firewall or e-mail gateway separates CallPil
from the Internet or intranet, then CallPilot must resolve only the IP address
the relay server, which is also entered during implementation. However, a D
server must, in turn, be available to the relay server to resolve the final 
destination address of the site’s name in outbound VPIM Networking mess
VPIM Networking Implementation and Administration Guide 105
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DNS and MX records
Where a gateway, proxy, relay server, or firewall intervenes between CallP
and the Internet or intranet, the DNS can be configured with mail exchange
(MX) records. This allows SMTP traffic from remote VPIM Networking sites 
be redirected through the gateway and then delivered to the local VPIM 
Networking system. The DNS does not have to be configured with MX reco
because there is an alternate mechanism for the left-hand side to be looked

A number of MX records may be specified, with the order in which they are
be used. The preference number in an MX record indicates the preference; 
number indicates a high preference.

For example, if messages addressed to 14165551234@acme.com are to b
delivered to the host machine mail.acme.com, then the DNS must be config
with an MX record, such as

■ acme.com IN MX 10 mail.acme.com

In this example, 10 is the preference number.

However, if you use another company or ISP to handle your SMTP mail 
services, the DNS must be configured with an MX record that indicates this
relationship, such as

■ acme.com IN   MX 10   mail.ourISP.net

MX record preference number
If your system directs incoming messages through a mail relay, you may se
MX records. The mail relay can use MX records in the DNS database to loc
the CallPilot server. If MX records are not used, the left-hand side of the VP
address is used.

The mail relay tries each of the hosts listed in the MX records, in order of 
preference. The host that handles the VPIM Networking messages must be
because CallPilot does not relay messages that cannot be delivered locally

Firewall
If the Internet is being used to transport VPIM Networking messages, a fire
must be in place and must support transmission of SMTP/MIME.

E-mail gateway server
VPIM Networking may be configured to forward all outbound SMTP messa
traffic to a machine that serves as an SMTP relay.
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If a proxy is to be used for this site, the proxy software must be configured 
recognize and handle messages for any other site. For example, the proxy w
domain name of example.com must have an entry that maps, for example, 
14165551234 at example.com to 14165551234 at test.example.com.

Incoming VPIM Networking messages are always received as SMTP proxie
port 25. How the message was routed to the site is irrelevant to CallPilot. F
example, CallPilot does not care if the incoming messages were routed thro
mail relays.

For outgoing messages, however, CallPilot is interested in the routing path
the message. The outgoing message can be routed directly to the destinati
system, or it can be routed through a mail server or a proxy server.

When you configure VPIM Networking, you specify the server that is used f
outgoing messages. If you use any other port but port 25 for outgoing mess
you also specify the port number.

Internet Mail Access Protocol (IMAP)
If local users use desktop clients that support IMAP, configure the Internet M
Client on CallPilot before implementing VPIM Networking.

Because IMAP also uses SMTP, some of the configuration of IMAP is 
completed on the same dialog boxes where VPIM Networking is configured

Complete the Incoming SMTP/VPIM messages box on the Message Delive
Configuration dialog box—SMTP/VPIM tab. Complete the SMTP/VPIM 
Server FQDN box on the Local Messaging Server Properties dialog box—
General tab. Add one SMTP/VPIM Networking Shortcut to the Local Prime
Switch Location Properties—SMTP/VPIM tab.

When you are implementing VPIM Networking, you may find these boxes 
already completed. Do not change their configuration or desktop users may
affected.

Windows NT configuration
Configure Windows NT for VPIM Networking. Configure

■ TCP/IP setup

■ server FQDN

■ DNS
VPIM Networking Implementation and Administration Guide 107
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■ time zone environment variable

See also
For a general overview of the implementation process, consult the Networking 
Planning Guide.

The Networking Planning Guide also provides a more detailed discussion abo
the preliminary requirements, the creation of network diagrams, and the 
maintenance of a network history.
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Planning and engineering considerations

Introduction
When implementing VPIM Networking, the following planning and engineeri
issues must be considered:

■ impact of VPIM Networking load on your local area network (LAN), 
proxies, firewalls, and mail relays

■ message handling abilities (throughput)

■ message queuing capacities

■ message delivery times

■ VPIM Networking limitations

LAN load
It is predicted that the sustained maximum load imposed by VPIM Network
on its connected LAN is 180 kbyte/s. This is less than 1 percent of the 10Ba
bandwidth and is equal to the estimated pump rate for the SMTP delivery 
process.

This load is independent of the aggregate number of SMTP connections on
allocated IP ports.

The average data rate imposed on the LAN by VPIM Networking in order to
keep four voice channels active is 21 kbyte/s. This is less than 1 percent of
10BaseT bandwidth.

For example, a 94-minute message creates a 33 Mbyte file that takes three
minutes to go from one VPIM Networking system to another.

Message handling abilities (throughput)
Message throughput by VPIM Networking to and from the SMTP network 
accessed by a LAN depends on the traffic conditions present on that LAN.

The time required to deliver a message also varies with the wide area netw
(WAN) facilities used to reach, and within, the Internet or intranet.
VPIM Networking Implementation and Administration Guide 109
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Message queuing capacities
In its role as a gateway device, VPIM Networking must queue all received 
messages.

Message delivery times
The total time to deliver a message from one VPIM Networking site to anot
consists of the following time factors:

■ message handling time of VPIM Networking—messages are prepared 
ESMTP/MIME transmission

■ transfer time on digital network to a receiving or intervening mail relay 
server

■ store and relay time for each mail server or proxy that handles the mes
between sending and receiving sites

VPIM Networking limitations
Operational performance depends on the characteristics of the Internet or 
intranet IP network accessed by the LAN. Factors that influence the reliabil
and throughput of messages transferred to the Internet or intranet may incl
the following:

■ LAN traffic from other sources

■ wide area network (WAN) characteristics and traffic

■ router capabilities

■ electronic mail gateways, proxies, relays, and routers

See also
For detailed planning and engineering information, consult the Planning and 
Engineering Guide.
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Gathering information

This chapter describes how to gather the information required to implemen
VPIM Networking. 

Information is required about the data network, the dialing plan configured o
the local switch location, and the other sites in the messaging network.

This chapter also describes how to gather information about the other sites 
messaging network, and how to convert this information into a messaging 
network representation.

In this chapter
Information required 113
VPIM Networking Implementation and Administration Guide 111
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Information required

In this section
Overview 114

Data network information 115

Determining the server FQDN 116

Determining the SMTP/mail proxy server FQDN 117

Switch information 118

Information required from switch 120

Information from other sites 121

Messaging network representation 122
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Overview

Introduction
Before you begin to implement VPIM Networking, gather the information th
you need. Having this information before you begin speeds the implementa
process. When you analyze the information for inconsistencies and 
incompleteness, you ensure that potential problems are resolved ahead of 

Required information
You must gather three types of information:

■ local data network information

■ local site information, especially about the switch configuration and dial
plan

■ messaging network information that is provided by all remote sites

Why gather information?
The gathered information is used to

■ Identify the sites in the messaging network.

■ Identify the networking protocols used among sites.

■ Identify the dialing plan used by each site.

■ Determine if the dialing plan needs any modification.

■ Create a messaging network representation.

■ Prepare for CallPilot configuration.
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Data network information

Introduction
VPIM Networking is implemented on top of the existing data network.

To configure VPIM Networking, you must know something about your local
data network and the remote data networks.

Data network
The following items were required when CallPilot was installed in your data
network:

■ FQDN of the outgoing SMTP mail server

■ IP address of the DNS

■ host name of the local CallPilot system

■ subnet mask used by the local CallPilot system

To implement VPIM Networking on CallPilot, the following additional 
information is needed:

■ FQDN of the local server

You must also know the FQDN of each remote server that is expected to 
exchange VPIM messages with the local CallPilot server.

Gathering this information requires collaboration with the messaging netwo
administrators at other sites.

Remote data network information
For each remote site with which the local site exchanges VPIM Networking
information, you must have the FQDN of the SMTP server.
VPIM Networking Implementation and Administration Guide 115
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Determining the server FQDN

Introduction
The server FQDN is required to configure VPIM Networking.

The server FQDN is based on the Windows NT setup configured on your sy
when the name of server was implemented.

Getting there  Windows NT > Start > Settings > Control Panel

To determine the server FQDN

1 On the Control Panel, select Network.

Result: The Network dialog box appears.

2 Select the Protocol tab.

3 Select TCP/IP Protocol in the Network Protocols list, and click Properties.

Result: The Microsoft TCP/IP Properties page appears.

4 Click the DNS tab.

5 Write down the host name and the domain name. 

Note: When combined, these become the server FQDN. A dot is inserted 
between the host name and the domain name to form the server FQDN. 

Example:  hostname and domainname.com are combined to create the 
server FQDN, hostname.domainname.com.

6 Click Close until the Control Panel closes.
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Determining the SMTP/mail proxy server 
FQDN

Introduction
When configuring VPIM Networking, you may need to provide the outgoing
SMTP or the mail proxy server FQDN, depending on your physical network
setup.

To determine the FQDN
The server that handles the outgoing messages for your local site already h
FQDN. Ask the data network administrator to provide the required FQDN.

The FQDN has a form similar to the following:

■ mail.company.com
VPIM Networking Implementation and Administration Guide 117
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Switch information

Introduction
Even though VPIM Networking transmits messages over the data network, 
switch network, dialing plan information is still required if messages are 
exchanged with integrated sites.

When you begin to implement VPIM Networking, the switch is already instal
and configured and is operational for CallPilot.

This means that the switch is set up for dialing among the sites in the mess
network. The dialing plans that are configured on the switch for making 
telephone calls between sites are also used to address messages among s

If messages are exchanged with open sites only, dialing plan information is
required.

Gather dialing plan information
You need the dialing plan information that is configured on the switch. You 
must know the dialing plan used in the messaging network and how all sites
one another.

The easiest way to gather this information is to ask the switch technician or
system administrator.

Gathering information directly from the switch
Gathering information directly from the switch is not recommended. The 
information that you require is found on several switch configuration files ca
overlays. Finding the information can be difficult and time-consuming.

If you must gather the information from the switch, consult your switch 
documentation for the proper procedures and detailed information on each 
overlay.

How dialing plans are used by VPIM Networking
The dialing plan that is configured on the switch is used by VPIM Networkin
VPIM Networking is designed to be virtually transparent.
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Users can address a VPIM Networking message to an integrated site by us
the same numbers that they would use to call that integrated site.

Example
To call the site in Dallas, Samantha Singh dials an ESN prefix, 7888, and th
extension number of the individual she is calling, 1234.

To send a message to the same user, she enters 75 to begin composing a 
message, and enters the ESN prefix and the extension number as an addre
VPIM Networking translates this information into a complete VPIM address
that forms the To: entry:

■ 12145551234@company.com

The 1214555 is a VPIM Network shortcut for the Dallas site configured in th
local database. The Dallas site must have corresponding information config
for its local site.
VPIM Networking Implementation and Administration Guide 119
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Information required from switch

Introduction
Switch configuration information is required to implement VPIM Networking

Information checklist
The following switch configuration information is required:

■ name or physical location of switch (useful to name the switch location
CallPilot)

■ dialing plan used

● Electronic Switched Network (ESN)

● Coordinated Dialing Plan (CDP)

● hybrid dialing plan, combining ESN and CDP

● another dialing plan, such as public switched telephone network (PS

■ if ESN or hybrid dialing plan is used:

● ESN access code

● ESN location codes

- local switch location

- remote switch location

● overlap of location codes with extension numbers

■ if CDP or hybrid dialing plan is used:

● CDP steering codes

- local switch location

- remote switch location

● overlap of steering codes with extension numbers

■ range of extension numbers used at the local site (for example, 7000–7

■ confirmation that all extension numbers at this switch location can be 
dialed directly from the local switch

■ confirmation that all extension numbers at this switch can be dialed in 
same way
120 CallPilot
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Information from other sites

Introduction
Implementation of a networking solution requires a coordinated effort. Many
decisions must be made before implementation begins.

Gather the following information from the other sites in the messaging netw
that exchange messages with the local site using VPIM Networking:

■ site names

■ Enterprise site IDs, if Enterprise Networking is implemented in the 
messaging network

■ fully qualified domain names (FQDNs) of the servers

■ dialing plan used between the local site and remote messaging servers

■ if any remote sites are NMS sites, the following information for each 
satellite switch location:

● switch location name

● switch type

● location ID
VPIM Networking Implementation and Administration Guide 121
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Messaging network representation

Introduction
A messaging network representation provides a complete summary of your
messaging network. It contains information about each of the sites and indic
the relationship between each pair of sites.

If sufficiently detailed, a messaging network representation is the primary 
source of information for implementing a messaging network.

The more detail you can supply, the easier you will find the process of 
implementation.

A diagram is the most suitable form of representing most messaging netwo
A spreadsheet is more appropriate for large messaging networks.

Definition: Messaging network diagram
A messaging network diagram is a graphical representation of your network
includes the following types of information:

■ all sites in the network

■ the protocols implemented at each site

■ how sites are connected

■ the protocol used among sites

■ site names and codes

■ dialing plan information

Definition: Messaging network spreadsheet
A spreadsheet is more appropriate for representing a large messaging netw
provides the same information as the diagram.

Benefits
There are many benefits to creating a representation of your messaging net
A representation

■ offers a clear view of how your network is connected
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■ gathers all the required information in one source

■ offers a way to assess the design and determine if there are any confli
resolve before implementation

■ provides a useful means of planning future modifications

■ helps during the analysis of traffic issues

■ reveals areas for improvement

■ provides support personnel with a concise, clear view of your messagin
and data networks

Coordinating efforts
Much of the information for your network representation must be provided b
the administrators of other sites. For example, you need to know the name,
server FQDN, and other information from every site with which you exchan
VPIM Networking messages.

Although each site administrator creates a representation, ideally one 
administrator should create a final version that is provided to all sites. This 
ensures that the representation is comprehensive and that each site uses th
information for implementation.

Protecting the representation
Your network representation contains sensitive information. Keep it properl
stored and protected as part of standard security procedures.

See also
For detailed instructions on how to create a network representation, as wel
several examples, consult the Networking Planning Guide.
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Configuring CallPilot for VPIM 
Networking

This chapter describes how to configure CallPilot during the VPIM Network
implementation process. 

The chapter introduces the concepts that are necessary to understand the 
configuration process and provides detailed configuration procedures.

In this chapter
Configuring CallPilot 127
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Configuring CallPilot

In this section
Overview 128

DNS server 129

Message delivery parameters—SMTP/VPIM tab 131

Configuring the message delivery parameters 136
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Overview

Configuring CallPilot
The implementation of VPIM Networking requires additional configuration o
CallPilot. The information that is entered determines how VPIM Networking
exchanges messages.

The configuration process depends on whether you plan to use VPIM 
Networking to exchange messages with open sites only, with integrated site
only, or with both integrated and open sites.

Before you begin
The CallPilot server and your network should be configured and tested.

If your VPIM Networking site is an NMS network, NMS should be configure
and tested.

You should know the addresses of several VPIM-compliant systems so tha
can test the configuration.

ATTENTION! It is strongly recommended that you perform each step 
the configuration process in the order presented.
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DNS server

Introduction
If VPIM Networking sends messages over the Internet, your site requires a
domain name system (DNS) server.

Your local site can maintain its own DNS server or use an Internet service 
provider (ISP). In both instances, however, additional configuration must be
done to the DNS server to make it work with VPIM Networking.

ISP coordination
Many smaller corporations have an external supplier, known as an Internet
service provider (ISP), supply DNS services.

If your data network uses an ISP, most of the setup is complete. The ISP fu
the following requirements:

■ registers a domain name on your behalf

■ gives the numeric IP addresses of the primary and secondary DNS ser

● These addresses are used to configure the TCP/IP stacks of the Me
Application Server.

Work with the ISP
Even if an ISP is supplying your DNS services, you must ensure that the 
configuration of the DNS server is complete. You must

■ Tell the ISP which DNS records you want to publish. These published 
records allow outside users to send SMTP messages to your network.

■ Have the ISP add another mail exchange (MX) record for the computer
accepts e-mail connections for your domain into the DNS database of 
ISP. This allows you to receive VPIM Networking messages over the 
Internet.
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■ Have the ISP add an A record, corresponding to the MX record, to the D
database of the ISP.

If you are using your own DNS servers
Many organizations set up and maintain their own DNS servers.

If your organization uses its own DNS servers, this guide assumes that the
already properly set up and configured.

However, VPIM Networking has specific requirements in the lookup table o
DNS server.

Maintain one DNS server
InterNIC does not grant a domain name to an organization unless there are
least two DNS servers. While most small organizations use an ISP to provi
both, and most large organizations maintain their own, some organizations
an ISP for one server and maintain another one themselves.

If this is the case for your organization, ensure that the DNS records of both
ISP and the local lookup tables are configured as described.

ATTENTION! An ISP is not behind a firewall. Check with your ISP to 
resolve security issues before deciding to use an ISP fo
mail services.
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Message delivery parameters—SMTP/
VPIM tab

Introduction
To implement VPIM Networking, you must set the message delivery parame
that establish how your local messaging server handles VPIM messages.

These parameters are set on the Message Delivery Configuration—SMTP/
VPIM tab.

. 

Outgoing and incoming SMTP/VPIM
If VPIM Networking is installed on your system, the following parameters ar
enabled by default:

■ Outgoing SMTP/VPIM

■ Incoming SMTP/VPIM

Clear these options to restrict the use of VPIM Networking.
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If you do not want local users to send VPIM Networking messages to any o
site, open or integrated, clear the Outgoing check box.

If you do not want local users to receive messages from any other site, ope
integrated, clear the Incoming check box.

To completely disable VPIM Networking, clear both options.

VPIM Compose Prefix
The VPIM compose prefix alerts CallPilot that the rest of the number that is
about to be entered is a VPIM address. You must define the VPIM compos
prefix.

The VPIM compose prefix is used by telephone users addressing open sites
a VPIM network shortcut. The shortcut must not be unique among the prefi
that are defined in the local network database. The VPIM compose prefix m
conflict with other numbers because, while the entire shortcut is unique, the
portion of it might conflict with another number in the network database.

The VPIM compose prefix must not conflict with any other prefixes used in 
system, such as the name dialing prefix or the AMIS compose prefix.

If users at your site do not use VPIM network shortcuts to address a messa
the VPIM compose prefix is optional.

Example
A VPIM open shortcut is defined as 1416597 = Nortel.ca. A VPIM compose
prefix, 22, is defined. Users can address to mailbox 1234 by entering 22 
1416597 1234.

The VPIM compose prefix does not conflict with the left-most digits of the 
VPIM shortcut.

ATTENTION! Clearing the Outgoing SMTP/VPIM check box also 
affects all Internet mail clients. If your system uses 
IMAP, messages are not exchanged. For a discussion 
IMAP security issues and how this check box is used, 
consult the Advanced Administration Guide. 
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When a VPIM compose prefix is not required

Telephone users
If a telephone user addresses a message to an integrated site using the ES
CDP dialing plan, the VPIM compose prefix is not required. In this case, the
dialing plan code is the unique identifier within the messaging network. Wh
the system locates the dialing plan code within the local network database,
the intended receiving site and the network protocol to be used are identifie

Example
A user addresses a message to a user at a remote site with an ESN compo
prefix and a mailbox number: ESN prefix 6333, mailbox 8080. CallPilot che
the network database for the ESN prefix. When it locates the prefix, it also 
knows the protocol that is used to send a message to that remote site. In th
case, the protocol is VPIM Networking.

Desktop users
Desktop users can enter a VPIM compose prefix to address to users at ope
VPIM sites. However, normally desktop users simply enter the full VPIM 
address.

Outgoing SMTP Mail/Proxy Server
An outgoing VPIM Networking message may go directly to the destination 
system, or it may be routed through a mail server or a proxy server. If the 
message is routed through a mail server or a proxy server, you must enter 
FQDN.

When you specify the mail server FQDN, you are telling your system which
server is ultimately responsible for handling the outgoing VPIM Networking
messages on behalf of the local site.

The specified outgoing server is not the first server contacted. An attempt is
made to find the destination host in the local DNS before using the configur
server. If the destination host is located in the DNS, this host is used. This 
arrangement allows corporate mail to be sent directly to servers on an intra
Mail to external sites is directed through the Internet and passes through m
servers or proxy servers.

Enter the server name in the SMTP mail/proxy server box.
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FQDN
While gathering the information to implement VPIM Networking, the data 
network administrator should have given you the outgoing SMTP mail or pr
server FQDN.

VPIM Open Shortcuts
Desktop users have no difficulty sending messages to users at open sites. 
typical open address consists of both numeric and alphabetic characters (fo
example, 14165971234@nortel.com). These are easy to enter with a comp
keyboard.

However, entering the alphanumeric, right-hand side, of an open address is
supported for telephone users. VPIM open shortcuts enable telephone use
address messages.

A VPIM open shortcut maps, or translates, the alphabetic domain name on
right-hand side to a numeric format (for example, 1416597 maps to nortel.c

A benefit of VPIM open shortcuts is that users have to remember only one 
of contacting a recipient.

Example
A desktop user addresses a user at Corporation Inc., an open site, as follow

■ 12045971234@corporation.com

A VPIM open shortcut is defined for this address as follows:

■ 1204597 = corporation.com

A telephone user is therefore able to address the user as follows:

■ VPIM compose prefix (15) + VPIM open shortcut (1204597) + mailbox 
number (1234)

■ 1512045971234

Restriction
The maximum number of VPIM open shortcuts is 500. 

Note: The shortcuts entered here are for open VPIM addressing. They are 
for sites that are not part of the private messaging network, or for sites that
only VPIM Networking to open sites.
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When sites are added to the VPIM open shortcuts
You might know of several open sites with which users at your local site wil
exchange VPIM Networking messages. You add these sites during the initi
configuration of VPIM Networking.

However, as local users use VPIM Networking and become comfortable wit
they will request the addition of more open sites to the list of shortcuts. 
Maintaining the VPIM open shortcuts is an ongoing task. The list should ref
the current needs of your local site.

For example, Betty is conducting extensive business with the Polar Ice 
Company in Anchorage. She wants to be able to send and compose messa
the marketing director at Polar Ice. She requests that Polar Ice be added to
list of VPIM open shortcuts so she can send messages from both her telep
and her desktop.

See also
For detailed procedures on maintaining the VPIM open shortcuts, consult 
Adding, modifying, and deleting VPIM open shortcuts on page 241.
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Configuring the message delivery parameters

Introduction
You must configure the parameters that determine how your system handle
messages.

These parameters are configured on the Message Delivery Configuration—
SMTP/VPIM tab.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > SMTP/VPIM tab
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To configure VPIM Networking parameters

1 To enable your site to send outgoing VPIM Networking messages, ensure 
the Outgoing SMTP/VPIM check box is selected.

2 To enable your site to receive incoming VPIM Networking messages, 
ensure the Incoming SMTP/VPIM check box is selected.

3 Enter a VPIM compose prefix.

Note: The VPIM compose prefix must be unique among the prefixes used 
by the site and cannot conflict with CDP steering codes or ESN prefixes.

4 Enter the address of the mail server or proxy server used by outgoing 
messages in the Outgoing SMTP Mail/Proxy Server box, if applicable.

Note: The address was collected during the information-gathering process.

5 Click Add New to add an VPIM open shortcut.

Result: The VPIM Open Shortcut tab appears.

6 Enter the numeric shortcut for the open site in the Shortcut box.

7 Enter the FQDN for the open site in the Domain Name box.

8 Repeat steps 5–7 for every required VPIM open shortcut.

9 Click Save.
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Adding sites to VPIM Networking

This chapter describes how to define the sites in the messaging network th
exchange messages with the local site using VPIM Networking.

This chapter describes how to configure the local messaging server and pr
switch location. It also explains how to add and configure the remote messa
servers and switch locations if the option to add networking sites is enabled
the system.

In this chapter
About the messaging network 141

Configuring the local site 147

Adding and configuring a remote site 173
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About the messaging network

In this section
Overview 142

Configuration and other networking solutions 144
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Overview

Introduction
A CallPilot messaging network consists of a local site and one or more rem
sites.

All sites in your private messaging network with which your local site 
exchanges messages must appear in the Messaging Network Configuratio
view. If a remote site is part of the messaging network, but the local site doe
exchange messages with that remote site using VPIM Networking, you do n
add that remote site to the tree view during the implementation of VPIM 
Networking.

To implement VPIM Networking, configure the local site and add and config
all remote sites that will exchange messages with the local site using VPIM
Networking.

See also
Sites are configured in the Messaging Network Configuration tree view. For
overview of how to work with the tree view, consult the relevant section in t
Networking Planning Guide.

Before you begin
You need the following before you begin:

■ Your messaging network representation is complete, and the required 
information is available:

● remote site name

● remote site switch location type

● remote site dialing plan information

● remote site VPIM Network shortcuts

● remote site loopback mailbox number

ATTENTION! It is strongly recommended that you complete each ste
in the configuration process in the order presented.
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● if remote site is a Network Message Service (NMS) site, all satellite
switch location information

■ If your local site is an NMS site, NMS is configured and tested.

■ If local desktop users use IMAP clients, the Internet Mail Client is 
configured and tested.

■ The VPIM message delivery parameters are configured.
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Configuration and other networking solutions

Introduction
If another CallPilot networking solution is installed on your local system, mo
of the local messaging server and local switch location configuration is 
complete.

Confirm the settings, and enter the information that is specifically required t
implement of VPIM Networking.

NMS local site
If your local site is an NMS site, NMS should be implemented and tested be
you begin to implement VPIM Networking.

If NMS is implemented, the NMS satellite switch locations for the local site 
appear in the Messaging Network Configuration tree view.

Remote sites
If another CallPilot networking solution is implemented on your system, rem
sites have been added and configured. These sites appear in the Messagin
Network Configuration tree view. These sites communicate with the local si
using the other networking solution.

When you implement VPIM Networking, you add and configure the remote 
sites that communicate with your local site using VPIM Networking. These s
appear in the tree view only as you add them.
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Example: Implementing VPIM Networking
In this example, you are the network administrator of Site 1. Working with th
network administrators of other sites, you have created a messaging netwo
representation. Note that many details are removed from this diagram for cl

Your local site has the following networking solutions: Enterprise Networkin
and VPIM Networking.

Since you are following the recommended order of implementation, you hav
implemented and tested Enterprise Networking. During this implementation
you configured the local site and added Sites 2, 4, 5, and 6 to your network
database, because these sites use Enterprise Networking to exchange mes
with your site.

To implement VPIM Networking, you complete additional details required fo
the local site configuration. You add VPIM open shortcuts to your network 
database, because local users will exchange messages with open sites. Yo
and configure Site 3 as a remote site.

G101139.ep

 Site 1  Site 2

 Site 3  Site 4

 Site 5  Site 6

VPIM

AMIS

Satellite Satellite

Enterprise

VPIM

Integrated AMIS
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Integrated AMIS

Integrated AMIS

Enterprise

Enterprise

Off-net
site

Satellite Satellite

PRIVATE MESSAGING NETWORK

Off-net
site
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Configuring the local site

In this section
Overview 148

Configuring the local messaging server 149

Configuring the local prime switch location 154

Configuring ESN information 160

Configuring CDP information 164

Configuring VPIM information 167

Configuring an NMS local site 171
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Overview

Introduction
When CallPilot is initially installed on your system, a local messaging serve
and a prime switch location are automatically added to the Messaging Netw
Configuration tree view.

Local messaging server name
By default, both the local messaging server and the prime switch location a
assigned the name “Untitled.” Assign new names to the local messaging se
and the prime switch location during configuration.

The local site receives its name from the name assigned to the local messa
server.

Configuration
Both the local messaging server and the prime switch location must be 
configured. 

Configuration of the messaging server consists of saving general informatio
about the messaging server, such as name and description, to the network
database.

Configuration of the prime switch location consists of saving general 
information about the switch location as well as detailed dialing plan 
information.

Configuring the local server if another messaging solution is 
implemented

If you have implemented another CallPilot networking solution on your loca
system, you have already completed much of the local messaging server 
configuration.

Complete the additional configuration required for VPIM Networking.
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Configuring the local messaging server

Introduction
You must configure the local messaging server to implement VPIM 
Networking.

The local messaging server is configured on the Local Messaging Server 
Properties—General tab.

. L

Name
By default, both the local messaging server and the prime switch location a
assigned the name “Untitled.” Assign new names during configuration.
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The messaging server is usually given a name that corresponds to its geog
location.

Local site name
The name given to the local messaging server becomes the name of the lo
site.

Server type
The local messaging server is always CallPilot.

Description
Provide a brief description of the messaging server, or implementation note
such as when the server was configured or who completed the configuratio
the Description box.

Send Messages to all other Servers
The Send Messages to all other Servers check box determines if the local s
can send messages to integrated remote sites in the messaging network.

This check box is selected by default and is cleared only under exceptional
circumstances.

When cleared, the local messaging server does not send messages to any
integrated remote site using any protocol. Messages can still be sent to ope
remote sites.

When to clear this option
This option lets you quickly disable messaging from your local site. Clear th
check box in emergency situations.

Restricting messages to individual sites
Clearing the Send Messages to all Other Servers check box is a quick way
disable the system. It is not used to restrict the sending of messages to indiv
sites.
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To prohibit the local messaging server from sending messages to a particu
integrated remote site, clear the Send messages to this Server check box o
Messaging Network Configuration—Remote Messaging Server Properties—
General tab.

For example, your messaging network has six sites. You want to send mes
to five of them. You select the Send Messages to all other Servers check b
while configuring the local messaging server. You clear the Send Message
this Server check box when configuring the remote server to which you do 
want to send messages.

Restricting messages to open remote sites
There is no way to prohibit the local messaging server from sending messag
specific open remote sites or to all open remote sites.

To restrict local users from sending messages to open sites, you must clea
Send Outgoing VPIM Messages checkbox on the Message Delivery 
Configuration—SMTP/VPIM Networking tab. However, this also restricts th
sending of messages to integrated remote sites.

Add/Update Remote Users on this Server
The Names Across the Network feature is available with Enterprise Network
only.

The Add/Update Remote Users on this Server check box enables the Nam
Across the Network feature to work with Enterprise Networking.

The Names Across the Network feature is not supported by VPIM Networki

If enabled, this check box should have been configured during the 
implementation of Enterprise Networking.

Enterprise Site ID
The Enterprise Site ID box is enabled only if Enterprise Networking is 
implemented on your local messaging server.

If enabled, this box should have been configured during the implementation
Enterprise Networking.
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Receive Message Text Info
The Receive Message Text Info check box is enabled only if Enterprise 
Networking is implemented on your local messaging server.

If enabled, this check box was configured during the implementation of 
Enterprise Networking.

Server FQDN
The fully qualified domain name (FQDN) of the VPIM Networking server is 
required.

The FQDN of the local messaging server is automatically added to the From
entry in an outbound message. It forms the right side of a VPIM address.

The FQDN is taken from the Windows NT TCP/IP configuration page. You 
determined the FQDN while gathering the required information for 
implementing VPIM Networking. For a review of how to determine the FQD
see Determining the server FQDN on page 116.

Note: If Internet Mail Client is implemented locally, and local desktop users u
IMAP clients, the Server FQDN box is already completed.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To configure the local messaging server

1 In the Messaging Network Configuration tree view, select the local 
messaging server.

2 On the File menu, click Open.

Result: The Local Prime Server Properties dialog box appears.

3 To change the name of the local messaging server, enter a new name in 
the Name box.

Tip: The name given to the local messaging server is also the name of the 
local site.

Note: The server type is always CallPilot and cannot be changed.

4 In the Description box, enter details about the local messaging server.
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5 To send messages to all other sites in the messaging network, ensure the 
Send messages to all other Servers check box is selected.

Note: The Add/Update Remote Users on this Server, Enterprise Site ID, 
and Receive Message Text Info boxes are enabled only if Enterprise 
Networking is installed. They are configured during the implementation of 
Enterprise Networking.

6 In the Server FQDN box, enter the fully qualified domain name of the local 
messaging server.

Tip: The FQDN is taken from the Windows NT TCP/IP Properties page.

Note: If another networking solution is already implemented on the local 
site, the FQDN box already contains either the correct FQDN or a 
placeholder. Confirm or replace the information as required. If Internet Mail 
Client is implemented, the FQDN box is already completed correctly.

7 Click Save.

Result: The information is validated and saved to the network database.

What’s next?
After configuring the local messaging server, you must configure the local pr
switch location.
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Configuring the local prime switch location

Introduction
You must configure the local prime switch location to implement VPIM 
Networking.

The final step in configuring the local site for VPIM Networking is to configu
the local prime switch location.

If any other networking solution is implemented
If another networking solution is implemented on the local site, the local sw
location configuration is already configured.

You must check the current configuration information. Make any necessary
modifications.

If NMS is implemented
If NMS is implemented on the local site, the information required for the loc
switch location configuration is already complete.

All satellite switch locations attached to the local prime switch location are a
already installed.

If no other networking solution is implemented
If no other networking solution is implemented on the local site, you must 
complete the General tab. You may have to complete the ESN tab or the C
tab, or both, depending on the dialing plan used on your local switch locatio
You must also complete the SMTP/VPIM tab.

Where the prime switch location is configured
The Prime Switch Location Properties dialog box consists of four tabs:

■ General

■ ESN

■ CDP
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■ SMTP/VPIM

General tab
Complete the General tab no matter what dialing plan your site uses.

ESN tab
Complete the ESN tab if the local site uses the ESN or a hybrid dialing plan

CDP tab
Complete the CDP tab if the local site uses the CDP or a hybrid dialing plan

SMTP/VPIM tab
Complete the SMTP/VPIM tab to implement VPIM Networking.
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Open VPIM Networking
If you are implementing VPIM Networking to work with open remote sites on
complete the following tabs:

■ General—set the dialing plan to none by clearing both dialing plan box

■ SMTP/VPIM
. 

Name
Every switch location needs a name that is unique within the messaging 
network. Usually, this name is the same as the name of the messaging ser
This ensures that the identity of the switch location within the network is 
immediately apparent. A geographic name is common.

For example, if a messaging server is named “Moscow,” the prime switch 
location is usually also named “Moscow.”

By default, the local prime switch location is given the name “Untitled.” This
name must be changed.

Description
The Description box is useful for short notes, reminders, or comments abou
switch location.

You might find it useful to specify your switch model, the date of the switch 
configuration, or contact information for the switch technician.

Enterprise Location ID
The Enterprise Location ID box is not enabled for the prime switch location

Note: The Enterprise Location ID for the prime switch location is always 0 a
cannot be changed.

Spoken Name Recorded
If your local site is not an NMS site, the Spoken Name Recorded check box
not enabled.

If your site is an NMS site, the Spoken Name Recorded check box was 
configured during the NMS implementation.
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Dialing plan information
You need detailed information about the dialing plan used by the local site w
you configure the local prime switch location.

Dialing plans for dialing to this location
You must specify which of the following dialing plans is used to dial to the lo
switch location:

■ ESN

■ CDP

■ hybrid that combines ESN and CDP

■ another dialing plan (such as PSTN)

When you configure the local prime switch location, you specify the dialing p
that is used to dial to the local site.

Note: If you use ESN anywhere in the messaging network, you must select 
because you need an ESN access code.

Mailbox specifications
The following boxes are dynamically enabled and disabled depending on th
dialing plan you have specified for the local prime switch location:

■ Mailbox addressing follows dialing plan

■ Mailbox prefixes

Mailbox addressing follows dialing plan
A mailbox number is often the same as the number used to dial a user. Wh
common, this arrangement is not a requirement. You must specify whether
your local site the mailbox number is the same as the number dialed.

For example, Li Chen’s mailbox number is 7575, but her extension number
8888.

The Mailbox addressing follows dialing plan check box is enabled only if NM
is installed on the local messaging server.

If enabled, this check box was configured during the implementation of NM
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Mailbox prefixes
A mailbox prefix is a leading string of digits that uniquely identifies a mailbo
number as belonging to a particular site.

If the local site does not have NMS installed, the mailbox prefixes are neve
required for the local prime switch location.

If the local site does have NMS installed, the mailbox prefix or prefixes are 
already properly configured.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To configure the Prime Switch Location Properties dialog box

1 In the Messaging Network Configuration tree view, select the local prime 
switch location.

2 On the File menu, click Open.

Result: The Prime Switch Location Properties—General tab appears.

3 To change the name of the local prime switch location, enter a name in the 
Name box.

4 In the Description box, enter details about the local prime switch location.

Note: The Enterprise location ID is always 0 and cannot be changed.

5 Confirm the status of the Spoken Name Recorded box.

Note: This box is enabled only if NMS is installed and was completed 
during NMS implementation.

6 Specify the dialing plan used to dial the local prime switch location. Select 
the

● ESN check box if ESN is used

● CDP check box if CDP is used

● ESN and CDP check boxes if a hybrid dialing plan is used

Note: Leave both check boxes clear if another dialing plan, such as PSTN, 
is used.

7 If the local site is an NMS site, check the configuration of the Mailbox 
addressing follows dialing plan check box and the Mailbox prefixes boxes.
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8 Determine whether you must complete another tab. If not, click Save to 
close the dialog box. 

9 Select another tab to continue the configuration.

What’s next?

If the local site uses an ESN, CDP, or hybrid dialing plan
After you complete the General tab, you must complete the ESN tab, or the 
tab, or both tabs, depending on the dialing plan used.

If the local site uses another dialing plan
If your local site uses another dialing plan, such as PSTN, complete the VP
tab.
VPIM Networking Implementation and Administration Guide 159



Adding sites to VPIM Networking  Standard 1.0

 

re 
Configuring ESN information

Introduction
If the local prime switch location uses either an ESN dialing plan or a hybrid
dialing plan, you must complete the ESN tab.

You must provide the ESN access codes and ESN location codes. These a
combined to create the ESN prefix.

See also
For a description of the ESN dialing plan and how it works, consult the 
Networking Planning Guide.

. 
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ESN Access Code used by this location
The ESN access code is used to access ESN routing in the same way that
access code, such as 9, is used to dial out to the public network from a priv
network.

Typically, all switches in a messaging network use the same ESN access c

ESN Location Codes
An ESN location code is a routing prefix that identifies a location within a 
network. It is usually three digits long, but can be up to ten digits long.

You must also indicate the number of digits in the ESN location code that 
overlap the mailbox number.

The ESN Location Codes list contains all ESN location codes currently assig
and indicates the overlap between the ESN location code and the mailbox 
directory numbers.

ESN location codes can be added, modified, or deleted at any time. The ES
location codes must always match the dialing plan configuration on the swi

ESN location code capacity
The maximum number of ESN location codes for a switch location is 30.

ESN location code overlap
When you are entering the dialing plan information for the local site, you mu
calculate the number of digits in the ESN prefix that overlap the digits in the
local extension.

If there is overlap between the rightmost digit or digits of the location code a
leftmost digit or digits of the extension number, enter the amount of overlap

The following table provides examples of ESN location code overlap.

Access 
code

Location 
code

Extension 
number

Number dialed by users at 
other sites Overlap

6 338 8300 63388300 0

6 338 8300 6338300 1
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration > Prime Switch 
Location Properties > ESN tab

To configure the ESN information

1 Enter the ESN access code.

2 To add a new location code, click the Add New button.

Result: The New ESN Location Code Properties dialog box appears.

3 In the Location Code box, enter the location code.

4 In the Overlap box, enter the number of digits in the extension number that 
overlap the location code.

5 Click Save.

Result: The location code and overlap are validated and appear in the ESN 
Location Codes list box on the ESN tab.

6 Repeat steps 3–5 for each ESN location code required.

6 300 8000-8999 63008300-63008999 0

6 302 25000-26999 63025000-63026999 1

Access 
code

Location 
code

Extension 
number

Number dialed by users at 
other sites Overlap
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7 When you have finished configuring the ESN information, determine if you 
must configure CDP information. 

● If yes, click the CDP tab. 

● If no, click Save to validate the ESN configuration information and sa
it to the database.

What’s next?
If your local prime switch location uses the hybrid dialing plan, click the CD
tab to continue configuring the local prime switch location.
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Configuring CDP information

Introduction
If the local switch location uses either a CDP dialing plan or a hybrid dialing
plan, complete the CDP tab.

You must provide the CDP steering codes.

See also
For a general description of the CDP dialing plan and how it works, consult
Networking Planning Guide.

. 
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CDP Steering Codes
A CDP steering code is a site prefix that identifies the local site within the 
network. Therefore, a CDP prefix must be unique for all switches in the 
messaging network.

CDP steering codes are determined by the switch technician. 

The CDP steering codes defined on the switch are entered on CallPilot bec
the system must be able to identify the steering code in the mailbox numbe
determine the site.

The CDP Steering Codes list box contains all CDP steering codes currently
assigned to the switch location. The list box also indicates the overlap betw
the CDP steering codes and the mailbox directory numbers.

CDP steering codes can be added, modified, or deleted.

CDP steering code capacity
The maximum number of CDP steering codes for a switch location is 500.

CDP steering code overlap
When entering the dialing plan information, you must calculate the number 
digits in the CDP steering code that overlap the digits of the local extension

If there is overlap between the last digit or digits of the steering code and th
first digit or digits of the extension number, enter the amount of overlap.

Normally, the steering code overlaps with the first few digits of a local extens
number.

The following table provides three examples of CDP steering code overlap:

Steering 
code

Extension 
number

Number dialed by users at 
other sites Overlap

22 22345 2222345 0

22 22345 222345 1

22 22345 22345 2
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration > Prime Switch 
Location Properties > CDP tab

. 

To configure the CDP information

1 To add a new steering code, click the Add New button.

Result: The New CDP Steering Code Properties dialog box appears.

2 In the Steering Code box, enter the steering code.

3 In the Overlap box, enter the number of digits in the extension number that 
overlap the steering code.

4 Click Save.

Result: The steering code and overlap are validated and appear in the 
CDP Steering Codes list box on the CDP tab.

5 Repeat steps 1–4 for each CDP steering code required.

6 When you have added all the necessary CDP steering codes, click Save.

Result: The information is validated and saved to the network database.

What’s next?
Complete the SMTP/VPIM tab, and configure the VPIM Networking shortcu
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Configuring VPIM information

Introduction
You must configure SMTP/VPIM network shortcuts if telephone users are go
to address messages to remote sites in your messaging network. These ar
attached to all outgoing messages.

The SMTP/VPIM networking shortcuts are configured on the SMTP/VPIM t

SMTP/VPIM Network Shortcuts
Although you can define up to 30 SMTP/VPIM network shortcuts, most 
messaging networks need only one or two.
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The SMTP/VPIM network shortcuts defined for the local prime switch locatio
provide a way to create the left side of the From: entry in a message heade
They are not shortcuts in the sense that they are only a few digits long.

SMTP/VPIM network shortcuts are also used to identify local addresses of 
incoming messages.

Note: SMTP/VPIM network shortcuts are defined on the New SMTP/VPIM 
Prefix Properties dialog box. The VPIM prefix is the SMTP/VPIM network 
shortcut.

Example
With the following SMTP/VPIM network shortcut defined:

■ 1416777

the From: entry sent with an outbound message from mailbox xxxx is

■ From: 1416777xxxx@serverFQDN

where xxxx is the extension number.

Relationship to PSTN
Usually, the SMTP/VPIM network shortcut corresponds to the PSTN numb
for the local site.

If the telephones are not directly dialable from the PSTN and calls are route
a switchboard, enter the switchboard number with an overlap of 0. For exam
14165557000, overlap 0.

Note: It is strongly recommended that you use PSTN numbers as the SMTP
VPIM network shortcuts.

Length of shortcuts
Although it might be tempting to define short SMTP/VPIM networking 
shortcuts, such as 4588, avoid doing so. 

ATTENTION! The shorter a SMTP/VPIM network shortcut is, the mor
likely it will conflict with the left-hand side of another 
open VPIM address. 
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For example, if your organization owns the telephone numbers 141659770
7999 and the mailboxes are 7000-7999, then define 14165977, overlap 1—
1416597, overlap 0. This avoids a mismatch with an open VPIM address, s
as 16165972134@neighbor.com.

SMTP/VPIM Network Shortcuts Overlap
When entering the dialing plan information, you must calculate the number 
digits in the VPIM network shortcut that overlap the digits of the local 
extension.

If there is overlap between the last digit or digits of the shortcut and the firs
digit or digits of the extension number, enter the amount of overlap.

Note: If Internet Mail Client is implemented locally, and local desktop users u
IMAP clients, one network shortcut is already configured.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration > Prime Switch 
Location Properties > SMTP/VPIM tab

To configure the VPIM information

1 To add a new SMTP/VPIM network shortcut, click the Add New button.

Result: The New SMTP/VPIM Prefix Properties dialog box appears.

2 In the Prefix box, enter the SMTP/VPIM network shortcut in dialable format. 

Note: A PSTN format is recommended. Only one SMTP/VPIM network 
shortcut is required.
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3 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the shortcut.

4 Click Save.

Result: The shortcut and overlap are validated and appear in the SMTP/
VPIM Network Shortcuts list box on the SMTP/VPIM tab.

5 Repeat steps 1–4 for each network shortcut required.

6 When you have added all the necessary network shortcuts, click Save.

Result: The information is validated and saved to the network database.

What’s next?
If the local site is not an NMS site, you have completed the configuration of
local site and are ready to begin adding and configuring remote sites.

If the local site is an NMS site, complete the configuration of the local site. S
Configuring an NMS local site on page 171.
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Configuring an NMS local site

Introduction
If your local site is an NMS site, you configured the local prime switch locat
and the local satellite switch locations during the implementation of NMS.

You must complete two steps to implement VPIM Networking:

■ Check the current configuration.

■ Configure the SMTP/VPIM tab for all switch locations.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To configure a local satellite switch location for VPIM Networking

1 Select the local satellite switch location.

2 On the File menu, select Properties.

Result: The Properties dialog box for the selected switch location appears.

3 Check the current configuration, and make changes if necessary.

4 Click the SMTP/VPIM tab.

5 To add a new SMTP/VPIM network shortcut, click the Add New button.

Result: The New SMTP/VPIM Prefix Properties dialog box appears.
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6 Enter the SMTP/VPIM networking shortcut in the Prefix box and the overlap 
with the local mailbox numbers.

7 Click Save.

Result: The SMTP/VPIM network shortcut appears in the SMTP/VPIM 
Network Shortcuts list box on the SMTP/VPIM tab.

8 Repeat steps 5–7 for each SMTP/VPIM network shortcut required.

9 When you have added all required SMTP/VPIM networking shortcuts, click 
Save.

Result: The information is validated and saved to the network database.

10 Repeat steps 1–9 for all switch locations in the local site.

What’s next?
You are ready to begin adding and configuring the remote sites that use VP
Networking to exchange messages with your local site. See the section Adding 
and configuring a remote site on page 173.
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Adding and configuring a remote site

In this section
Overview 174

Configuring a remote messaging server 175

Configuring a remote prime switch location 183

Configuring a remote satellite switch location 197

Recording a spoken name 201

Importing a spoken name 203

Non-CallPilot remote sites 205

Meridian Mail remote sites 207

Norstar Voice Mail remote sites 208

VPIM-compliant third-party systems 209
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Overview

Introduction
When you implement VPIM Networking, you add to the Messaging Network
Configuration tree view all the remote sites that use VPIM Networking to 
exchange messages with the local site.

Every remote site added to the tree view must be configured.

Information required
The information that you enter when configuring a remote site reflects the 
information that is configured for that site in its own local network database.
example, you enter the name of that site and its FQDN. You must get this 
information from the remote network administrator.

But configuring a remote site is not simply copying the information provided
the remote site. You also enter information that reflects how your local site 
communicate with that remote site. For example, for each remote site you de
whether your local site sends messages to this particular remote server.

Main steps
There are three main steps to adding a remote site to your local network 
database. For each remote site, you must add and configure

■ the remote messaging server

■ the remote prime switch location

■ the remote satellite switch locations, if the remote site is an NMS site

Network representation
Much of the information that you must provide while configuring a remote 
messaging server is contained in the network diagram or spreadsheet.
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Configuring a remote messaging server

Introduction
When CallPilot is initially installed on your system, your local site, consisting
a local messaging server and a local prime switch location, is automatically
added to the Messaging Network Configuration tree view.

However, you must manually add each remote site that exchanges messag
with the local site using VPIM Networking to the Messaging Network 
Configuration tree view. Both the remote messaging server and the remote
prime switch location must be configured.

The following tabs must be completed for each remote messaging server:

■ Remote Messaging Server Properties—General tab

■ Remote Messaging Server Properties—Connections tab

Remote servers and other networking solutions
If you have implemented another CallPilot networking solution on your syste
you have already added remote sites to the Messaging Network Configurat
tree view.

The process of adding a remote site is essentially the same regardless of th
networking solution being implemented. However, when you add remote si
during the implementation of VPIM Networking there are important differenc
to consider.
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Remote Messaging Server Properties—General tab
The Remote Messaging Server Properties—General tab contains detailed 
information about the remote messaging server and defines how the local s
and the remote site exchange messages.

. 

Name
You should assign the remote messaging server the same name that was 
assigned by its local network administrator. This makes the network easier 
administer and maintain, because all network administrators use the same n
for the same sites.

For example, if a remote site calls itself Connecticut, you should name it 
Connecticut when you add it to the Messaging Network Configuration tree v

Server type
The remote messaging server can be any of the following types:
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■ CallPilot (CallPilot)

■ Meridian Mail Net Gateway (MMNG)

■ Norstar Voice Mail (Norstar)

■ Meridian Mail

■ Other

Description
Provide a brief description of the remote messaging server or useful notes,
as when the messaging server was configured or who completed the 
configuration. 

Send Messages to this Server
The Send Messages to this Server check box interacts with the Send Messa
all Other Servers check box on the Local Messaging Server Properties—Ge
tab.

When you configured the local messaging server, you decided if you wante
local messaging server to send messages to all remote messaging servers
option is selected by default and is cleared under exceptional circumstance
only. 

However, you can still stop the delivery of messages to specific remote 
messaging servers. The Send Messages to this Server check box enables 
block the delivery of messages from your local messaging server to a partic
remote site.
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Example
In the following diagram, Helsinki is configured to deliver messages to all ot
sites. However, the network database records for Paris and Cairo specify th
messages are not sent to these messaging servers. Messages are sent to 
and Korso-Rekola. Therefore, while the potential exists for sending messag
all remote sites, only two sites receive messages from Helsinki.

Send local user information to this Server
The Send local user information to this Server check box determines if the 
Names Across the Network feature is used with this remote site. If enabled
feature was configured during the implementation of Enterprise Networking

Enterprise Site ID
The Enterprise Site ID box is enabled only if Enterprise Networking is insta
on the local site. 

G100995.eps

Helsinki
Local Network Database

Send
Messages
to All Other
Servers?

YES

Local Messaging
Server

NO

Remote Messaging
Server
Cairo

Send messages
to this server?

NO
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Remote Messaging
Server
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All remote sites connected to a site that has Enterprise Networking installed
must have an Enterprise site ID, regardless of the actual protocol used with
site.

Therefore, if Enterprise Networking is installed locally, when implementing 
VPIM Networking you must enter the site ID for all remote sites, even those 
exchange messages with the local site using the VPIM protocol.

Consult the network representation for the correct Enterprise site IDs.

Send Message Text Info to this Server
This check box applies only to remote sites that use Enterprise Networking
exchange messages with the local site. For remote sites that use VPIM 
Networking, this box is not applicable.

Server FQDN
You must provide the FQDN of the server at the remote site.

This FQDN forms the right side of the To: entry in a message header for a 
message sent to this site. The right side is formed from a VPIM networking
shortcut for this remote site.
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Remote Messaging Server Properties—Connections tab
The configuration of a remote messaging server continues on the Connecti
tab.

Network protocol
When implementing VPIM Networking, the only box that you must complete
this tab is Network protocol. Select VPIM, because your local site uses VPI
Networking to exchange messages with this remote site.

To use a particular protocol, both sites must have the same networking solu
installed and implemented.

If a remote site does not use the same protocol as the local site, the followi
occurs when the local site attempts to send a message:

■ The message is not delivered.

■ An error message is generated.
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■ The remote site is put into error status.

Other boxes
When you implement VPIM Networking, you do not complete the Connectio
DNs or the Enterprise Passwords boxes.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > Messaging 
Network Configuration 

To configure a remote messaging server

1 In the Messaging Network Configuration tree view, select Remote Server 
Maintenance.

2 On the File menu, click New > Messaging Server.

Result: The Remote Messaging Server Properties dialog box appears.

3 On the General tab, in the Name box, enter the name of the remote 
messaging server.

4 Select the server type from the Server type box.

5 In the Description box, enter details about the remote messaging server.

6 To enable the local messaging server to send messages to this remote 
messaging server, ensure that the Send Messages to this Server box is 
selected.

7 If an Enterprise site ID is required, enter the unique site ID number of the 
remote messaging server or a valid placeholder.

8 In the Server FQDN box, enter the FQDN of the remote site.

Note: The FQDN is supplied by the remote network administrator.

9 To continue configuring the remote messaging server, click the 
Connections tab.

. 

10 From the Network protocol list, select VPIM.

11 Click Save.

Result: The information is validated and entered into the local network 
database.
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What’s next?
After you add information about the remote messaging server into your loca
network database, you must also add information about the remote prime s
location.
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Configuring a remote prime switch location

Introduction
When you added a remote messaging server to the Message Network 
Configuration tree view, a corresponding prime switch location was added.

A remote prime switch location must be configured. This process is almost 
identical to configuring the local prime switch location.

Remote Prime Switch Location Properties dialog box
The remote prime switch location is configured on the Remote Prime Switc
Location Properties dialog box, which has four tabs:

■ General

■ ESN

■ CDP

■ SMTP/VPIM

General tab
Completing the General tab is mandatory.

ESN tab
Complete the ESN tab if an ESN or hybrid dialing plan is used with this rem
site.

CDP tab
Complete the CDP tab if a CDP or hybrid dialing plan is used with this remo
site.

SMTP/VPIM tab
Because your local site is using VPIM Networking to transfer messages wit
this remote site, must complete the SMTP/VPIM tab.
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Remote Prime Switch Location Properties—General tab
. 

Name
Assign a unique name to each switch location. The name should correspon
the switch location to make the location easy to identify. A street name or c
name is a good choice.

The remote prime switch location is automatically given the name of the rem
server that was added to the Messaging Network Configuration tree view. T
name can be changed.

Description
Enter short notes or comments about the remote prime switch location in th
box.
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Enterprise Location ID
The Enterprise Location ID box is enabled only if Enterprise Networking is 
implemented on the local site.

A location ID is required for all remote sites if Enterprise Networking is 
installed locally, even if another protocol is used to exchange messages wit
site.

The location ID of the remote prime switch location is set to 0 by default an
cannot be changed.

Spoken Name Recorded
When local users compose a message to this remote site or use the playba
feature to determine the sender of a message, they hear a message that id
the sender. The content of the message depends on whether a spoken nam
that remote site is recorded.

If a spoken name is recorded, voice mail users hear the location name follo
by the local mailbox directory number.

Example: “Dallas, Mailbox 2346.”

Spoken name not recorded
If a spoken name is not recorded, local users hear a general message that 
not identify the sender’s site by name.

For example, for an ESN switch location, users hear the ESN location prefi
followed by the local mailbox directory number.

Example: “Mailbox 6444 2346.”

When a spoken name is not desirable
You may decide that you do not want local users to hear a spoken name fo
particular remote site. For example, if CDP is used for messaging with this 
remote site and the mailbox numbers follow the dialing plan, you may decid
that a recorded spoken name is unnecessary. In this case, do not record or 
a spoken name.

Ways to add a spoken name recording
There are two ways to add a spoken name recording: record a spoken nam
directly by clicking the Record button, or import a prerecorded message.
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Dialing plan information
Provide general information on the dialing plan used by the switch.

The dialing plan boxes have complex interactions. They are dynamically 
enabled or disabled depending on the choices made. Complete all enabled
boxes.

Dialing plans for dialing to this location
You must specify which dialing plan is used to dial this remote switch locati
from the local switch location. There are four possible dialing plans:

■ ESN

■ CDP

■ hybrid, combining ESN and CDP

■ other (such as PSTN)

Mailbox addressing follows dialing plan
When a mailbox follows the dialing plan, a user dials and addresses a mes
to a recipient in the same way. There are two ways to achieve this 
correspondence:

■ A user’s mailbox number and extension number are the same.

■ The addressing plan and the dialing plan are the same.

If either situation is true, select the Mailbox addressing follows dialing plan 
check box.

Clear this option if users at the site do not dial and address recipients in the 
way.

Example: If the local ESN prefix is 6222 and the local mailbox is 1234, remo
users can dial the local user with the numbers 62221234, which is the ESN
prefix and the mailbox number combined.

Example: If the CDP steering code is 22 and the local mailbox is 1234, rem
users can dial the local user with the number 221234, which is the steering 
and the mailbox number combined.

Mailbox prefixes
Mailbox prefixes are used by users on other switches to address a messag
users on the local switch.
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A mailbox prefix must be provided if the mailbox does not follow the dialing
plan or if another dialing plan, such as PSTN, is used.

A mailbox prefix does not have to overlap with local mailbox numbers. Two
mailbox prefixes can be entered. Either prefix can be used to address any 
mailbox at the local site. Normally, however, only one prefix is required.

Usually, the mailbox prefix is a shortcut. A mailbox prefix can be any numbe
long as it does not conflict with other network data.

A mailbox prefix can also be the entire telephone number of the site, includ
country code, city/area code, and exchange.

Example: If the mailbox prefix is 22 and the mailbox number of a local user
6565, users at other switches address the local user by dialing 226565.

Dialing prefix
A dialing prefix is needed if the local site uses another dialing plan, such as
PSTN, and users at your local site use a dialing prefix to reach users at this
remote location.

Usually, if the Dialing prefix box is enabled, you enter the prefix.

In a few cases, a dialing prefix is not needed. For example, if the mailbox 
number, with the mailbox prefix, can be dialed directly, a dialing prefix is no
needed. This situation is rare because most systems use at least some sor
access code.

Dialing plan information required
The dialing plan boxes have complex interactions and are dynamically ena
and disabled depending upon choices made. Complete all enabled boxes.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration 
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To configure the remote prime switch location

1 In the Messaging Network Configuration tree view, select the remote prime 
switch location.

2 On the File menu, select Properties.

Result: The Remote Prime Switch Location Properties dialog box appears.

3 On the General tab, in the Name box, enter the name of the remote prime 
switch location.

4 In the Description box, enter details about the switch location.

Note: The Enterprise Location ID is always set to 0 for remote prime switch 
locations and cannot be changed.

5 If needed, click Record to record a spoken name for the site, or click Import 
to import a prerecorded spoken name.

Note: For instructions on how to record a spoken name, see Recording a 
spoken name on page 201.

For instructions on how to import a spoken name, see Importing a spoken 
name on page 203.

6 Specify the dialing plan used to dial this remote switch location. Select the

● ESN check box if ESN is used

● CDP check box if CDP is used

● ESN and CDP check boxes if a hybrid dialing plan is used

Note: Leave both check boxes clear if another dialing plan, such as PSTN, 
is used.

7 If the mailbox addressing follows dialing plan, select the Mailbox 
addressing follows dialing plan check box.

8 Complete the Mailbox prefixes boxes and Dialing prefix box if necessary.

9 Determine whether you must complete another tab. If not, click Save to 
close the dialog box. 

ESN information
If the remote prime switch location uses an ESN or hybrid dialing plan, 
complete the ESN tab.

The procedure for configuring the ESN information for a remote prime switc
location is identical to the procedure used for the local prime switch location
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For a review of the ESN access codes, ESN location codes, and overlap, co
Configuring ESN information on page 160.

To configure the ESN information

1 Open the Messaging Network Configuration—Remote Prime Switch 
Location Properties—ESN tab.

2 Enter the ESN access code.
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3 To add a new location code, click the Add New button.

Result: The New ESN Location Code Properties dialog box appears.

4 In the Location Code box, enter the location code.

5 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the location code.

6 Click Save.

Result: The location code and overlap are validated and appear in the ESN 
Location Codes box on the ESN tab.

7 Repeat steps 3–6 for each ESN location code required.

8 When you have finished configuring the ESN information, determine if you 
must configure CDP information. If yes, click the CDP tab. If no, click Save.

What’s next?
If your remote prime switch location uses the hybrid dialing plan, click the C
tab to continue configuring the local prime switch location.

If the local prime switch location uses only the ESN dialing plan, click Save
validate the configuration information and save it to the network database.

. 

CDP information
If a CDP dialing plan or a hybrid dialing plan is used to connect the local sit
the remote site, complete the CDP tab.
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Configuring the CDP information for a remote prime switch location is identi
to configuring the local prime switch location.

For a review of the CDP steering codes and overlap, consult Configuring CDP 
information on page 164.
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To configure the CDP information

1 Open the Messaging Network Configuration—Remote Prime Switch 
Location Properties—CDP tab.

2 Click the Add New button.
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Result: The New CDP Steering Code Properties dialog box appears. 

3 In the Steering Code box, enter the steering code.

4 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the steering code.

5 Click Save.

Result: The steering code and overlap are validated and appear in the 
CDP Steering Codes box on the CDP tab.

6 Repeat steps 2–5 for each CDP steering code required.

7 When you have added all necessary CDP steering codes, click Save.

Result: The information is validated and saved to the network database.

What’s next?
Click the VPIM tab to finish configuring the remote prime switch location.

VPIM information
To use VPIM Networking to exchange messages with the remote site, com
the VPIM tab.

Configuring the VPIM information for a remote prime switch location is 
identical to configuring the local prime switch location. See Configuring VPIM 
information on page 167.

For a review of SMTP/VPIM network shortcuts consultHow VPIM Networking 
works on page 61.
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Relationship of SMTP/VPIM network shortcuts
The SMTP/VPIM network shortcuts that you enter for a remote site in your 
network database must correspond to the SMTP/VPIM network shortcuts th
the remote site defines for itself in its network database.

There must be a correspondence because, when a message is received fro
remote site, the message contains a From: entry in the message header th
contains a SMTP/VPIM network shortcut for that site.
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To configure the VPIM information

1 Open the Messaging Network Configuration—Remote Prime Switch 
Location Properties—SMTP/VPIM tab.

2 Click the Add New button.
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Result: The New SMTP/VPIM Prefix Properties dialog box appears.

3 In the Prefix box, enter the SMTP/VPIM network shortcut in dialable, PSTN 
format.

Note: Only one SMTP/VPIM network shortcut is required.

4 In the Overlap box, enter the number of digits in the mailbox number that 
overlap the shortcut.

5 Click Save.

Result: The shortcut and overlap are validated and appear in the SMTP/
VPIM Network Shortcuts list box on the VPIM tab.

6 Repeat steps 2–5 for each network shortcut required.

7 When you have added all necessary SMTP/VPIM network shortcuts, click 
Save.

Result: The information is validated and saved to the network database.
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Configuring a remote satellite switch location

Introduction
If a remote site is an NMS site, you must add and configure each of its sate
switch locations. This information is saved to the local network database.

Although a prime switch location is added automatically when a remote site
added to the Messaging Network Configuration tree view, you must manua
add each satellite switch location of a remote NMS site.

Capacity
An NMS site can have up to 59 satellite switch locations.

Organization
When you add a satellite switch location, this location appears in the Messa
Network Configuration tree view. Satellite switch locations are listed 
alphabetically below the prime switch location.
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Where to configure a satellite switch location
To configure a satellite switch location, complete the General tab of the Sate
Switch Location Properties dialog box.

You must also complete the tabs that correspond to the dialing plan used b
local site.

ESN tab
Complete the ESN tab if an ESN or hybrid dialing plan is used.

CDP tab
Complete the CDP tab if a CDP or hybrid dialing plan is used.

SMTP/VPIM tab
Because your local site is using VPIM Networking to transfer messages wit
this remote site, complete the SMTP/VPIM tab.
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Spoken Name Recorded
When local users compose a message to a remote satellite switch location 
the playback feature to hear who sent a message, the name of the switch lo
is played. 

If a spoken name is not recorded, local users hear the full DN, such as “Ma
64441234.” If a recording of the spoken name is available, local users hear
switch location name followed by the mailbox number, such as “Milan 1234
You can either record a message using the telephone or import a prerecord
WAV file.

When a recording of the spoken name is available, Yes appears in the Spo
Name Recorded box.

If you do not want your local users to hear the name of this satellite switch 
location when composing messages or using playback, do not record a mes
For example, if you are using CDP to transfer messages to the site and ma
numbers follow the dialing plan, you may feel that a spoken name is 
unnecessary.

Dialing plan interaction
The dialing plan boxes are dynamically enabled or disabled depending on t
choices made. Complete all enabled fields.

SMTP/VPIM network shortcuts
Specify SMTP/VPIM network shortcuts for the satellite switch location on th
SMTP/VPIM tab.

Every satellite switch location must have unique SMTP/VPIM network 
shortcuts, because the shortcuts are used to identify the locations.

Every satellite switch location must have at least one SMTP/VPIM network 
shortcut. Every VPIM network shortcut must be unique within the messagin
network.

See also
Configuring a satellite switch location for a remote site is  identical to 
configuring a remote prime switch location for a remote site. 

For a review, consult Configuring a remote prime switch location on page 183.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To configure a remote satellite switch location

1 On the Messaging Network Configuration tree view, highlight the remote 
messaging server.

2 On the File menu, select New > Switch location.

Result: The Satellite Switch Location Properties dialog box appears.

3 Complete the General tab.

Note: For detailed instructions on how to record a spoken name, see 
Recording a spoken name on page 201. For detailed instructions on how to 
import a spoken name, see Importing a spoken name on page 203.

4 Complete the ESN tab, the CDP tab, and the SMTP/VPIM tab as required.

5 Click Save.

Result: The information is validated and the satellite switch location is 
added to the remote site.

6 Repeat steps 1–5 for each satellite switch location required.

7 When all satellite switch locations are added, click Save to save them to the 
Messaging Network Configuration tree view.
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Recording a spoken name

Introduction
You can create a recording of the name of a switch location. A recorded nam
heard by a local user whenever an address is played back. A recorded nam
site is played if a user does not have a personal recorded name.

Local switch location
If your local site is not an NMS site, a spoken name is not required for the l
site.

If your local site is an NMS site, you can decide if you want to record a spo
name. For example, if the NMS site uses CDP, you may decide a spoke na
not necessary.

Remote switch location
A spoken name should be available for every remote site in your Message 
Delivery Configuration tree view.

The recording is played when local users compose messages to the remote

Importing a spoken name
If you do not want to record your own voice using the telephone, you can im
a prerecorded WAV file. See Importing a spoken name on page 203.

Before you begin
You need a telephone to serve as a microphone.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration
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To record a spoken name

1 In the Messaging Network Configuration tree view, select the switch 
location of the site for which you want to record a spoken name.

2 On the File menu, select Open.

Result: The Switch Location Properties dialog box appears.

3 On the General tab, click Record.

Result: The Specify Phoneset dialog box appears.

4 Enter the telephone number of the telephone to be used as a microphone 
and click Dial.

Result: The telephone rings and the Voice Recorder dialog box appears.

5 Answer the telephone.

6 In the Voice Recorder dialog box, click Record.

7 Speak the name of the site into the telephone.

8 Click Stop.

9 To review the recording, click Play.

10 If you are satisfied with the recording, click Done.
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Importing a spoken name

Introduction
You can import a prerecorded file of the name of a switch location. The 
recording is heard by a local user whenever an address is played back. A 
recording for a site is played if a user does not have a personal spoken nam

Local switch location
If your local site is not an NMS site, a spoken name is not required for the l
site.

If your local site is an NMS site, you can decide if you want to import a spok
name. For example, if the NMS site uses CDP, you may decide a spoken na
not necessary.

Remote switch location
A spoken name should be available for every remote site in your Message 
Delivery Configuration tree view.

The recording is played when local users compose messages to the remote

Recording a spoken name
If you do not want to import a prerecorded spoken name, you can record yo
own voice message using the telephone. See Recording a spoken name on page 
201.

Before you begin
A prerecorded WAV file must be available. Check the quality of the recordin
before importing the file.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration
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To import a prerecorded file

1 In the Messaging Network Configuration tree view, select the switch 
location of the site for which you want to import a prerecorded file.

2 On the File menu, select Open.

Result: The Switch Location Properties dialog box appears.

3 On the General tab, click Import.

Result: The Open dialog box appears.

4 Select the WAV file, and click Open.

Result: The file is imported.

5 Close the Open dialog box.
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Non-CallPilot remote sites

Introduction
VPIM Networking can exchange messages between a CallPilot system and
following non-CallPilot remote systems:

■ a Meridian Mail (Release 11 or later) system through a Meridian Mail N
Gateway (Release 1 or later) system

■ a Norstar Voice Mail (Release 3 and later) system

■ VPIM-compliant systems from other vendors

Coordination
If a remote site is a non-CallPilot system, you must coordinate with the netw
administrator of that remote site to ensure that the systems are properly 
configured. You must share the standard information that is required betwe
any sites in a messaging network.

Example
The two sites must coordinate dialing plans and ensure that there are no con
in the configuration information.

Adding and configuring the remote site
Adding a non-CallPilot remote site to the local network database is exactly 
same as adding a CallPilot remote site.

To configure the non-CallPilot remote site, you require no special informatio
You must only specify the server type on the Remote Messaging Server dia
box. The rest of the configuration is the same as the configuration of a Call
remote site.

Server type
Specify the server type of a non-CallPilot system on the Messaging Networ
Configuration—Remote Server Properties—General tab.
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Instructions for the remote administrator
For both Meridian Mail and Norstar Voice Mail systems, no special instructio
must be communicated to the remote network administrator.

The remote administrator adds the CallPilot site to the remote network data
like any other remote site. No special configuration is required.
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Meridian Mail remote sites

Introduction
CallPilot can use VPIM Networking to exchange voice messages with a 
Meridian Mail system through a Meridian Mail Net Gateway system. Fax an
text messages are not supported.

If a remote site is a Net Gateway system, you must coordinate with the netw
administrator of that site to ensure that the systems are properly configured

Most of the coordination involves standard information that is required betw
any sites in a messaging network. For example, you need to coordinate you
dialing plans and Enterprise site IDs.

Net Gateway sites that support VPIM messages use the internal dialing pla
VPIM shortcuts. For example, a Net Gateway site that uses the ESN locatio
code 338 has a shortcut, 6338.

Special coordination
Some coordination is not typical, and you may need to work with the remot
administrator of the Net Gateway site to ensure that configuration is correct

Net Gateway supports the Meridian Mail Remote Voice User Propagation 
feature. This feature is equivalent to the CallPilot Names Across the Netwo
feature.

VPIM Networking does not support Names Across the Network. Therefore,
when the remote administrator of the Net Gateway site adds your site to tha
network database.

■ The Remote Voice User Propagation option must be turned off.

■ The Entrust encryption option for your site must be turned off.

■ The remote administrator must describe your site as “Another” system
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Norstar Voice Mail remote sites

Introduction
CallPilot can use VPIM Networking to exchange messages with Norstar Vo
Mail systems.

If a remote site is a Norstar system, you must coordinate with the network 
administrator of that site to ensure that the systems are properly configured

The coordination involves standard information that is required between an
sites in a messaging network, for example, site names and dialing plan 
information.

Instructions for the remote Norstar administrator
There are no special instructions for the remote Norstar administrator.

The CallPilot site is added to the network database like any other site.

Norstar does not support ESN or CDP dialing plans. Typically, a Norstar sit
configured to use another dialing plan and has a mailbox prefix defined.

Norstar supports voice, fax, and text messages.
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VPIM-compliant third-party systems

Introduction
VPIM Networking uses industry standards and can exchange messages wi
VPIM-compliant third-party systems.

However, there may be special restrictions or considerations.

Confirm compliance and compatibility
Consult the documentation of the third-party system to determine if there ar
any special configuration considerations or restrictions in functionality.

Determine how the third-party system must be configured to exchange mess
with your site.

Confirm the capabilities enabled on the third-party system to ensure that fea
are available.

See also
For a review of VPIM conformance specifications, consult AppendixA, VPIM 
conformance.
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Testing and backing up VPIM 
Networking

This chapter describes how to test the configuration of VPIM Networking. T
test suite ensures that VPIM Networking is working properly both locally an
with remote sites.

This chapter also describes how to create a backup of your system to ensu
the configuration is not lost due to system failure.

In this chapter
Tests and backups 213
VPIM Networking Implementation and Administration Guide 211
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Tests and backups

In this section
VPIM Networking test suite 214

Connectivity test 215

Loopback test 217

Telnet test 219

Backing up VPIM Networking 220
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VPIM Networking test suite

Introduction
After implementing VPIM Networking, test the system to ensure that it is 
working properly.

The VPIM Networking test suite determines if the local site is correctly 
configured and if the local site can exchange messages with remote sites.

Perform the tests in sequence. If any test in the suite fails, resolve the prob
before continuing with the tests.

Note: These tests are not intended to validate the VPIM compliance of a thi
party system. It is assumed that any system you communicate with is comp

Test suite
The VPIM Networking test suite consists of three tests.

Before you begin
You must work with the remote network administrators at each remote site.

Review each test before beginning. Ensure that the preliminary requiremen
each test are met.

This test Determines if

connectivity test there is connectivity between sites.

loopback test messages can be exchanged with other sites
the messaging network.

telnet test the outgoing mail server is operational.
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Connectivity test

Introduction
Packet Internet Groper (ping) is a utility that is used to test TCP/IP networks
the Internet. The ping test, or pinging, determines if there is connectivity 
between sites.

Pinging
At its simplest, pinging consists of sending a message and waiting for its ec
be bounced back.

You ping another computer on a data network to ensure that it can be reac
from your computer.

Pinging has several functions, including troubleshooting  and testing a data
network.

A series of ping tests should be performed when you set up VPIM Network

Getting there  Windows NT > Start > Program > Command Prompt

To perform the ping test

1 In the MS-DOS window, at the prompt, enter the following command:

ping <destinationFQDN>

2 Check the results of the ping test.

Evaluating results
The ping test is successful if you receive a reply to the message.

The test is not successful if you receive a request timed out message. This
message indicates that there is no connection or a bad connection between

The test is not successful if you receive an invalid FQDN message. This 
message indicates that an invalid IP address was entered.
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If the test is not successful
If you do not receive a response, check the destination FQDN and perform 
test again. If you receive no response a second time, ping another server F
If you receive a response from this site, it is possible that there is a problem
the host that you originally tried to contact.
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Loopback test

Introduction
The loopback test verifies that messages can be sent from a local site to a r
site, and returned to the local site.

The loopback test is performed with every remote site with which the local s
exchanges VPIM messages.

The loopback test consists of composing and sending a message to the loo
mailbox on a remote site. The loopback mailbox automatically returns the 
message to the originator.

Before you begin
Before performing a loopback test, ensure a loopback mailbox exists on ev
remote site to be tested.

Ask each remote network administrator for the loopback mailbox number. I
loopback mailbox is not available, any mailbox on the remote system can b
used. In this case, the message must be replied to manually from the remo
system. Ask for help from the remote administrator to complete this test.

To perform the VPIM Loopback test

1 Log in to CallPilot.

2 Press 75 to compose a message.

3 Enter the network address of the remote site.

4 Record the message.

Note: Tag the message as urgent.

5 Press 79 to send the message.

6 Wait for your Message Waiting Indicator (MWI) to activate. 

Note: The MWI indicates that the message was successfully returned. This 
may take several minutes.

7 Log in and listen to the message.

8 Log out of the system.
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Evaluating results
The test is successful if you hear the message that you recorded.

The message is not successful if you receive a non-delivery notification.

If the test is not successful
If the VPIM loopback test fails or produces unexpected results, do the follow

■ Confirm the loopback mailbox number with the remote administrator.

■ Perform the test again.

■ If still unsuccessful, consult the Operational Measurement reports to 
determine the following:

● Is the remote site operational?

● Are both sites configured to use VPIM Networking to exchange 
messages?
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Telnet test

Introduction
The telnet test determines if an outgoing server is operational. If the local s
uses an outgoing server for VPIM Networking, you must be able to telnet to
server. If the local site does not use an outgoing server, you must be able t
telnet the server for each remote site.

Getting there  Windows NT > Start > Programs > MS-DOS

To perform the telnet test

1 At the prompt, enter the following:

telnet <server FQDN> <port number>

Note: In most instances, the port number is 25. Change the port number if 
necessary.

2 Press Enter.

Result: The Telnet window opens.

3 Check the results.

● 220 <message>  indicates a successful test

● 421 <message>  indicates the server is currently busy. Try the test
again.

● A warning box with a connection failure message indicates there ma
problems with the server.

4 After completing the test, close the MS-DOS window.
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Backing up VPIM Networking

Introduction
When all tests of the system are successfully completed and VPIM Network
is working properly, perform a backup.

The backup ensures that the configuration is not lost due to a system failur

Backup schedule
Perform backups as part of the implementation process and as part of regu
maintenance activities.

Implementation backup
Perform a manual backup as the final step in the VPIM Networking 
implementation process. This backup is needed even if the system is config
to perform an automatic backup.

In the unlikely event that the system experiences a disk failure before the 
automatic backup takes place, the network configuration could be lost.

Maintenance backup
Perform a backup whenever VPIM Networking configuration information is 
modified.

System backup components
A system backup consists of two parts:

■ a switch backup

■ a CallPilot backup

Switch backup
For detailed instructions on how to perform a switch backup, consult your 
switch documentation.

CallPilot backup
You can perform a full or partial backup of your CallPilot server.
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For detailed instructions on performing a CallPilot backup, consult the relev
section in the Advanced Administration Guide.
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Maintaining VPIM Networking

After you complete the VPIM Networking implementation, you only need to
perform regular maintenance.

This chapter describes the maintenance procedures that must be performe
regularly. The chapter also describes maintenance procedures that are perf
on an as-required basis, such as when there are changes at sites in the me
network.

In this chapter
About maintaining VPIM Networking 225

Regularly scheduled maintenance tasks 231

As-required maintenance tasks 235
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About maintaining VPIM Networking

In this section
Overview 226

Network history 228

Printing configuration information 230
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Overview

Introduction
After VPIM Networking is successfully implemented and tested, it requires 
maintenance.

There are two types of maintenance tasks:

■ regularly scheduled tasks

■ as-required tasks

Regularly scheduled tasks
Regularly scheduled tasks include

■ checking the network status

■ reviewing Operational Measurement (OM) reports
Although you can perform regularly scheduled tasks at any time, they shou
performed at least once a week. Because these tasks do not interfere with 
normal operation of VPIM Networking, you can schedule them for a conven
time.

If you monitor the performance of your messaging network, you avoid futur
problems. Careful monitoring shows bottlenecks in the system and indicate
how the system can be improved.

Monitoring can also help in planning and forecasting future requirements.

As-required tasks
Perform as-required tasks as needs arise. These tasks include

■ adding additional shortcuts

■ disabling and enabling VPIM Networking

■ modifying settings
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■ adding or deleting remote sites from the network database

Perform a backup following maintenance
If an as-required task involves a change in the network configuration, perfo
backup of the system.

ATTENTION! Because as-required tasks may affect the performance
the entire system, they must be carefully scheduled for
off-peak hours.
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Network history

Introduction
Keep detailed records of your network’s history. These records can

■ Indicate significant performance or equipment issues that real-time 
monitoring cannot detect.

■ Provide a background for comparing with the current information.

■ Help future system administrators who need information about growth,
equipment, maintenance, and system configuration changes.

■ Provide information needed during support calls.

Information to record
A network history typically includes the following types of information:

■ installation dates and descriptions

■ contact information for all key personnel involved in system installation
and configuration

■ details of software installed on the messaging server, including version

■ installation progress and results, including tests

■ diagrams of the initial and subsequent messaging networking 
configurations

■ any problems encountered and their solutions

■ hardware and software changes

■ current configuration information

■ changes to the messaging network configuration

Records should be easy to access and read. Graphics, including hand-draw
sketches, can be very useful.

Where to keep the records
Records for each site in a network should be kept in one location. They can
kept in a log or online. Note, however, that online records cannot be access
the system fails.
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The information contained in your network is valuable and should be safely
stored. In the wrong hands, this information might result in the loss of syste
integrity.

See also
For a detailed description of messaging network histories, consult the 
Networking Planning Guide.
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Printing configuration information

Introduction
Printouts of the system configuration are often included in a network history
You can print all configuration information contained in your local network 
database.

Note: The tree view of the messaging network contained in the Messaging 
Network Configuration dialog box cannot be printed.

When to print configuration information
Although configuration information is always available in the most recent 
backup of your network database, you may find it convenient to make printo
as well.

Printouts of the configuration information are especially useful in the followi
situations:

■ You must fax information to a remote network administrator.

■ You are keeping a network history.

■ You are planning to change a configuration or delete an item from the 
Messaging Network Configuration tree view and want a hard copy of th
original configuration.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration or Messaging 
Network Configuration

To print configuration information

1 Open the dialog box that contains the information to be printed.

2 With the dialog box open, click the Print button.

Result: The content of the dialog box, including all tabs, is printed.
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Regularly scheduled maintenance tasks

In this section
Reviewing OM reports and alerts 232
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Reviewing OM reports and alerts

Introduction
Operational Measurement (OM) reports and alerts provide detailed informa
on the status and performance of VPIM Messaging.

Open Networking Activity report
The Open Networking Activity report provides information on AMIS 
Networking and VPIM Networking activity with open sites. The VPIM 
Networking statistics are combined with AMIS Networking statistics to open
sites if AMIS Networking is implemented.

Networking Activity report
The Networking Activity report provides summary information on network 
message traffic to sites within the messaging network. The report identifies
protocol used to exchange messages with each remote site.

Failed Networking Sessions alert
The Failed Networking Sessions alert is triggered when the number of 
networking session failures exceeds a threshold percent of total attempts.

Review schedule
Although you can review OM reports at any time, you should review them a
least weekly.

Access to OM reports is restricted
The generation of OM reports is a restricted activity that is determined by ac
level. If you do not have the necessary access, you must ask your system 
administrator to generate the reports.
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See also
For additional information on reports and alerts, including how to generate 
interpret them, consult the Reporter Guide.
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As-required maintenance tasks

In this section
Overview 236

Clearing a disk full condition 237

Disabling and enabling VPIM Networking 238

Adding, modifying, and deleting VPIM open shortcuts 241

Modifying the local site configuration 243

Add, modify, or delete a remote site 245

Locating an item in the tree view 247

Modifying a remote site configuration 248

Deleting items from the tree view 250

Modifying dialing plan information 253
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Overview

Introduction
As-required maintenance tasks are performed only when necessary.

Typical as-required maintenance tasks include

■ clearing a disk full condition

■ modifying the configuration of the local site

■ adding a remote site to the messaging network

■ deleting a remote site from the messaging network

■ modifying the configuration of a remote site

■ disabling and enabling the messaging network

Maintenance coordination
Most as-required maintenance tasks must be coordinated with the network
administrators of the remote sites.

Changes that you make to the local site configuration must be communicat
all remote sites. These changes must be reflected in the remote network 
databases.

Similarly, if the configuration of a remote site is changed, these changes mu
communicated to you. You must make the changes in your local network 
database.

Coordination must be timely
Coordination among the sites in the messaging network must also be timely
network databases must correspond with one another, or VPIM Networking
cannot work properly.
236 CallPilot



November 1998 Maintaining VPIM Networking 

n 
 

IM 

es.

om 

sult 
Clearing a disk full condition

Introduction
VPIM Networking messages consume more system memory resources tha
those of other networking solutions. Under some circumstances, especially
during periods of intense usage, the hard disk may become full.

Impact of a disk full condition
If the hard disk of the name of server cannot store anymore messages, VP
Networking is shut down.

When a disk full condition occurs,

■ Incoming messages, in any protocol, are not delivered to local mailbox

■ Outgoing VPIM Networking messages are not delivered to remote 
destinations, because temporary disk space is required for message 
conversions.

To clear a disk full condition
Ask users to remove all unnecessary messages from their mailboxes.

If this does not create sufficient free space, manually clear old messages fr
the disk.

See also
For a detailed discussion of the disk full condition and ways to avoid it, con
the Maintenance and Diagnostics Guide.
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Disabling and enabling VPIM Networking

Introduction
You may need to disable VPIM Networking sometimes. When you disable 
VPIM Networking, users cannot compose, send, or receive VPIM message

You might disable VPIM Networking to

■ Prevent system abuse.

■ Clear the system of undeliverable messages that are using up system 
resources.

When VPIM Networking is disabled, messages sent with other networking 
solutions are still permitted. Each messaging solution is disabled and enab
independently.

Degrees of disabling
There are three degrees of disabling VPIM Networking:

■ disabling outgoing VPIM Networking messages

■ disabling incoming VPIM Networking messages

■ disabling both outgoing and incoming VPIM Networking messages

Disabling outgoing VPIM Networking messages
When outgoing messages are disabled, the local system cannot send mess
using VPIM Networking to open addresses or integrated addresses. Howev
the system can still receive incoming VPIM Networking messages.

Disabling incoming VPIM Networking messages
When incoming messages are disabled, the local system cannot receive 
messages using VPIM Networking from open addresses or integrated addre
However, the system can still send outgoing VPIM Networking messages.
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Disabling both outgoing and incoming VPIM Networking messages
When both outgoing and incoming messages are disabled, the local system
cannot send or receive messages using VPIM from open addresses or inte
addresses.

Messages sent while system is disabled
When you disable outbound VPIM Networking, your local users can continu
compose and send messages. The messages composed by your local use
held in queue until the option is enabled or the message becomes stale.

When you disable the Incoming SMTP/VPIM networking  check box, messa
from remote systems are rejected. The remote system that sends the mess
informed of the status, and messages are not accepted. The way the remo
system handles this information depends on the system. For example, if the
remote system is CallPilot, the sender receives a non-delivery notification t
states that the system of the intended recipient is not accepting messages. 
compliant systems from other vendors may handle this scenario differently.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > SMTP/VPIM tab

ATTENTION! Disabling VPIM Networking may affect desktop users 
with IMAP clients. If your site uses IMAP, review the 
settings carefully.
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To disable and enable AMIS Networking

1 Do the following:

2 To save your settings, click Save.

When to disable a remote site
Disable a remote site if

■ The remote site is being modified.

■ There are problems with the switch network that are affecting a particu
remote site.

■ The system at the remote site is down because of hardware problems 
system upgrade.

■ The remote site is in error status and you are trying to determine why.

■ The site is being removed from the messaging network.

Impact of disabling a remote site
Disabling a remote site prevents any messages from being delivered to tha
However, messages can still be delivered to other remote sites.

Messages sent to a disabled remote site remain in the message queue unt
site is enabled or the message becomes stale.

IF you want to THEN

disable your system from receiving 
VPIM messages

clear the Incoming VPIM 
Networking check box.

disable your system from sending VPIM 
messages

clear the Outgoing VPIM Networking 
check box.

enable your system to receive VPIM 
messages

select the Incoming VPIM 
Networking check box.

enable your system to send VPIM 
messages

select the Outgoing VPIM 
Networking check box.
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Adding, modifying, and deleting VPIM open 
shortcuts

Introduction
To keep the exchange of VPIM Networking messages to open sites operati
optimally, keep the list of VPIM open shortcuts up-to-date.

Add VPIM open shortcuts for all frequently addressed open sites. Changes t
details of a shortcut should be reflected in the shortcut list promptly. Shortc
that are no longer used should be removed.

User needs determine shortcuts
The VPIM open shortcuts list is largely determined by the telephone users 
your local site. Users who address open sites from the desktop do not need
VPIM open shortcuts.

Telephone users need shortcuts to address a message to an open site. Wh
know of an open site, they will request that it be added to the list.

See also
For a review of how VPIM open shortcuts work, consult Message delivery 
parameters—SMTP/VPIM tab on page 131.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Message Delivery Configuration > SMTP/VPIM tab

To add a VPIM open shortcut

1 Select the Add New button.

Result: The VPIM Open Shortcut dialog box appears.

2 Enter the shortcut and the domain name.

3 Click Save.

Result: The information is validated and saved to the network database. 
The new shortcut appears in the VPIM Open Shortcuts list box.
VPIM Networking Implementation and Administration Guide 241



Maintaining VPIM Networking  Standard 1.0
To modify a VPIM open shortcut

1 In the VPIM Open Shortcuts list, select the shortcut to be modified.

2 Click Open. 

Result: The VPIM Open Shortcut dialog box appears.

3 Modify the shortcut and domain information as required.

4 Click Save.

Result: The information is validated and saved to the network database. 
The modified shortcut appears in the VPIM Open Shortcuts list.

To delete a VPIM open shortcut

1 In the VPIM Open Shortcuts list, select the shortcut to be deleted.

2 Click Remove.

Result: A confirmation message appears.

3 To delete the shortcut, click OK. 

To keep the shortcut, click Cancel.

4 Click Save.

Result: The information is validated and saved to the network database. 
The deleted shortcut no longer appears in the VPIM Open Shortcuts list.
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Modifying the local site configuration

Introduction
Over time, it may be necessary to modify the configuration of the local site.

Before you begin
Before modifying the configuration, print out all configuration information th
will be affected.

This printout becomes part of your network history. It is used if the modificat
is incorrect and you must return to the original configuration.

Communicate modifications
When you modify the configuration of the local messaging server or a local
switch location, whether prime or satellite, communicate the modifications to
remote network administrators.

All remote network administrators must reflect your modifications in their 
network databases. If you make changes independently, the messaging ne
will not perform correctly.

Further information
Configuration modifications are made on the properties dialog box where th
initial configuration was done. To review the configuration of any setting, 
consult the instructions for the initial implementation.

To review the settings on this 
Properties dialog box Consult

Local Messaging Server Configuring the local messaging 
server on page 149.

Local Prime Switch Location Configuring the local prime switch 
location on page 154.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To modify the configuration of the local site

1 From the Messaging Network Configuration tree view, select the item to be 
modified: local messaging server, local prime switch location, or local 
satellite switch location.

2 On the File menu, select Properties.

Result: The Properties dialog box of the selected item appears.

3 Make all necessary modifications.

4 Click Save.

Result: The information is validated and saved to the network database.

5 Repeat steps 1–4 for all items to be modified.

6 When all modifications are complete, click Close.

Local Satellite Switch Location Configuring an NMS local site on 
page 171.

NMS Implementation and 
Administration Guide

To review the settings on this 
Properties dialog box Consult
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Add, modify, or delete a remote site

Introduction
As your messaging network grows and changes, you may need to add or de
remote site, or to modify the configuration of an existing site.

It is important for all network administrators to keep their network databases
to-date.

Before you begin
Before adding, modifying, or deleting a remote site, print out all configuratio
information that will be affected.

Add a remote site
When a site is added to the messaging network, all sites add it to their 
Messaging Network Configuration tree view. The remote network administra
must provide the information needed to add and configure a remote site.

Modify a remote site
The configurations of both the messaging server and the switch locations ca
modified as needs change. For example, if a remote site upgrades its system
must modify its configuration information in your network database.

Note: The information in your network database must reflect the actual 
configuration of the remote site. The remote network administrator is 
responsible for informing you of all necessary changes.

Delete a remote site
When a site is removed from the messaging network, all sites must delete it 
their Messaging Network Configuration tree view.
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Impact on network database
Any additions, modifications, or deletions to remote sites are reflected in yo
network database. For this reason, the VPIM Networking tests should be 
performed again and a backup should be performed.
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Locating an item in the tree view

Introduction
It can be difficult to locate a particular remote site, messaging server, or sw
location in the Messaging Network Configuration tree view in a large messa
network.

There are two ways to locate an item in a large messaging network:

■ Scroll through the alphabetized list.

■ Use the Find feature.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To locate an item using Find

1 On the File menu, select Find.

Result: The Find dialog box appears.

2 Enter the name of the item to be located, and press the Find button.

Result: The located item is highlighted in the Messaging Network 
Configuration tree view.
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Modifying a remote site configuration

Introduction
The configuration of a remote site can be modified as needed.

Further information
Configuration modifications are made on the properties dialog box where th
initial configuration was made. To review the settings, consult the instructio
for the initial configuration.

Impact of modifications
Modifying the configuration of a remote system can affect the networking 
service between the remote site and your local site. Modifications to the 
following settings are especially important:

■ site ID

■ dialing plans

■ message transfer protocol

Enterprise Site IDs
Do not change the remote Enterprise Site ID unless the administrator at the
remote site notifies you of a change in that ID, or if the ID is incorrect.

To review the settings on this 
Properties dialog box Consult

Remote Messaging Server Configuring a remote messaging 
server on page 194.

Remote Prime Switch Location Configuring a remote prime switch 
location on page 202.

Remote Satellite Switch Location Configuring a remote satellite switch 
location on page 197.
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If you change the site ID to an invalid number by mistake, the system is una
to send or receive messages from the site.

Dialing plans
Do not change the dialing plan unless the dialing plan on the switch is chan

Network protocol
Do not change the network protocol unless all network administrators who 
the protocol agree to the change.

For example, suppose the local site was originally configured to use Integra
AMIS Networking to exchange messages with a remote site. However, the 
remote site has decided to implement VPIM Networking and can now use V
Networking to exchange messages with your site. In this instance, the mes
transfer protocol has changed.

Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To modify the configuration of a remote site

1 In the Messaging Network Configuration tree view, select the remote 
messaging server or switch location to be modified. 

2 On the File Menu, select Open.

Result: The Properties dialog box for the selected item opens.

3 Make all required modifications.

4 Click Save.

5 Repeat steps 1–4 for all items in the tree view that must be modified.

After modifications are complete
Modifications to the configuration of a remote site must be tested. Complete
test suite to ensure that the modifications are working properly.

When you are satisfied that your system is working properly, perform a bac
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Deleting items from the tree view

Introduction
The Messaging Network Configuration tree view contains all the sites in yo
messaging network. A site always consists of a messaging server and a pr
switch location. A site may also include satellite switch locations.

The messaging server, the prime switch location, and any satellite switch 
locations are listed in the tree view.

Sites and satellite switch locations are deleted from the Messaging Network
Configuration tree view.

Note: You cannot delete the local site. You can delete local satellite switch 
locations.

Multi-administrator environments
If several administrators maintain your local network database ensure that 
version of the Messaging Network Configuration tree view is up-to-date. Th
Messaging Network Configuration tree view is updated when it is initially 
opened. An open tree view is not updated when another administrator mak
changes.

To check the status of the view
To see if another administrator has made changes to the Messaging Netwo
Configuration tree view, on the View menu, click Refresh.

ATTENTION! When an item is deleted from the Messaging 
Network Configuration tree view, it is permanently
removed from the local network database. The 
information cannot be recovered. For this reason,
is strongly recommended that you print out the 
complete configuration of all items to be deleted. I
an item is accidentally deleted, you can use the 
printed information to add the item again.
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Getting there  Nortel SMI > Meridian Application Server > CallPilot > 
Networking > Messaging Network Configuration

To delete a remote site

1 Print the configuration details of the site to be deleted.

2 Open the folder of the remote site to see the messaging server, prime 
switch location, and any satellite switch locations.

3 In a multi-administrator environment, on the View menu, click Refresh.

4 Highlight the messaging server of the site to be deleted.

5 Select File > Delete.

Result: A confirmation box appears asking if you really want to delete the 
site from your local network database.

6 To delete the site, click OK.

Tip: You can also delete a highlighted remote site by clicking the Delete 
button.

Deleting several remote sites at once
If you must delete several remote sites from the local network database, yo
may find it more efficient to delete them all at once instead of individually.

To delete several remote sites at once

1 Print the configuration details of all sites to be deleted.

2 Highlight all the remote sites to be deleted.

Tip: To select more than one item in the tree view, press Ctrl and right-click 
the mouse.

3 Select File > Delete.

Result: A confirmation message appears.

4 Click OK to delete the items. Click Cancel to keep the items.
VPIM Networking Implementation and Administration Guide 251



Maintaining VPIM Networking  Standard 1.0

itch 
Deleting a satellite switch location  
If there are changes to an NMS site, you can delete one or more satellite sw
locations from the local site or from any remote sites.

If a satellite switch location is removed from an NMS site, is must also be 
removed from the local network database.

To delete a satellite switch location

1 Print the configuration details of the satellite switch location.

2 In a multi-administrator environment, on the View menu, click Refresh.

3 Highlight the satellite switch location to be deleted.

4 On the File menu, click Delete.

5 Select File > Delete.

Result: A confirmation message appears.

6 Click OK to delete the item. Click Cancel to keep the item.
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Modifying dialing plan information

Introduction
After you establish a dialing plan, you rarely modify it. Modifications to a 
dialing plan affect users and may require considerable relearning of the sys

However, if modifications are necessary, they are usually guided by change
made by the switch technician. These changes can be local or remote.

Switch changes
If any changes to the dialing plan are made on a switch, the network databa
the sites in the messaging network must reflect these changes. If changes 
made locally, ensure that all remote sites are notified.

To modify the dialing plan information
If you need to modify the dialing plan, follow the general instructions to mod
the local and remote sites.

Modifying CDP steering codes
Modifications to the CDP steering codes are more complicated. For a detai
review of how to plan for and implement changes, consult Chapter 4, “Diali
plans and networking,” in the Networking Planning Guide.
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Troubleshooting VPIM Networking

Although testing and regular maintenance ensure that VPIM Networking is 
working properly, the system may experience occasional problems.

This chapter describes how to diagnose and correct these problems.

In this chapter
Troubleshooting 257
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Troubleshooting

In this section
Overview 258

Troubleshooting basics 260

TCP/IP troubleshooting 261

Messages are not delivered 263
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Overview

Introduction
Troubleshooting a messaging network can be complicated. To simplify the t
use a systematic approach. The following table explains an approach that y
can apply to troubleshooting.

Step Action

Step 1 Define the problem clearly. Collect all symptoms.

Step 2 Gather information about the problem.

Step 3 Determine possible causes. Attempt to narrow the possible ca

Step 4 Create a plan of action. Always begin with the most likely caus

The plan should focus on manipulating one variable at a time. F
example, instead of changing all message delivery parameters
once, change just one and then test the system again.

Step 5 Work through the action plan. Whenever possible, test the sys
to see if the problem is solved. Gather information for all chang
in your network history.

Step 6 If the problem is corrected, ensure that any additional actions 
completed. For example, if you have to inform remote network 
administrators of any changes, contact them immediately.

If the problem is not corrected, create another plan of action tha
based on the next most likely cause.

Step 7 If you are unable to solve the problem, contact your technical 
support representative. Make sure you have detailed informatio
about the problem and the solutions you have attempted to solv
and their results. For example, if you have performed tests, hav
the results.
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Hardware problems
If you are unable to locate the problem in the CallPilot configuration, your 
system may be experiencing hardware problems that are not related to 
networking.

Perform a basic hardware check. Examine all connections.
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Troubleshooting basics

Introduction
Most problems have simple causes that are easily missed. When troublesho
always:

■ Check all cables and connections.

■ Check the error messages in the Event Browser.

■ Check users’ mailbox capabilities.

Error code range
VPIM Networking errors have the following ranges:

■ Message Transfer Agent (MTA) errors: 54100–54199

■ Internet Mail Agent (INA) errors: 54800–54899
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TCP/IP troubleshooting

Introduction
Problems with the TCP/IP data network affect the performance of VPIM 
Networking.

This discussion is intended as a brief introduction to TCP/IP troubleshootin
For more detailed information, consult your local data network administrato

Main steps
There are two steps to troubleshooting:

1. Ensure that you can ping successfully.

2. Ensure that you can establish a session with a host.

Definition: Ping
The ping utility measures the time that it takes for a packet of information to
travel from one host to the next.

To ping

1 Ping the loopback address (127.0.0.1) to verify that TCP/IP was installed 
and loaded correctly. 

Note: If this step is unsuccessful, check your TCP/IP installation.

2 Ping your IP address to verify that it was configured correctly. 

Note: If this step is unsuccessful, check the configuration in the Network 
program of the Control Panel.

Check the following:

a. Address is entered correctly.

b. IP address is valid.

c. IP address follows addressing guidelines.
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3 Ping the IP address of the default gateway to verify that the gateway is 
functioning and configured correctly. 

Note: If this step is unsuccessful, check that the IP address is correct.

4 Ping the IP address of a remote host to verify the connection to the data 
network. 

If this step is unsuccessful, do the following:

a. Ensure IP routing is enabled.

b. Verify that the IP address of the default gateway is correct.

c. Ensure the remote host is functional.

d. Verify that the link between routers is operating.
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Messages are not delivered

Introduction
Sometimes messages sent with VPIM Networking are not delivered. There
several causes of messages that are not delivered.

However, before you assume that a message is not delivered, attempt to 
determine its status.

Determine if messages are not delivered
You must first determine if messages are actually not delivered.

On occasion, a message transmitted over the Internet can take several day
reach its destination. Determine when the message was sent before conclu
that the message is not delivered.

A receiving system can be configured to not send confirmation of receipt 
notifications. Therefore, if you tag a message for acknowledgment, you may
receive an acknowledgment.

The routers that handle the message as it is transmitted over the Internet m
unable to handle certain message types, including acknowledgments and n
delivery notifications.

Not receiving a non-delivery notification should not be taken as evidence th
message is delivered. If a non-delivery notification is generated by a remote
the routers that handled the message as it was transmitted back to the orig
may not handle the message type correctly. It is possible for telephone use
to receive a non-delivery notification because of this format incompatibility.

If you suspect that messages are not delivered but need to confirm their sta
you may need to contact the recipients directly.
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VPIM conformance

This appendix provides a detailed conformance table.

In this appendix
VPIM profile 267
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VPIM-compliant messaging systems 
requirements

Introduction
To be considered VPIM-compliant, a messaging system must meet certain
requirements.

Number of recipients and message length
The VPIM standard does not restrict the number of recipients in a single 
message. It also does not limit the maximum message length. The limitatio
disk storage will affect the accepted message length.

However, CallPilot does have restrictions. CallPilot cannot deliver a messa
body that is longer than 120 minutes. This length is also affected by the 
limitations of disk storage.

Mail relays may also impose restrictions on message length.

Date and time stamps
The originating VPIM Networking system uses the date and time stamp pas
from MC. If the time zone environment variable (TZ) is configured in Window
NT, VPIM Networking includes the time zone offset and time zone name wh
constructing the string.

The receiving system accepts time stamps and discards any time zone offs
time zone name fields. They are discarded because CallPilot treats time sta
as the originator’s local time, so conversion to the recipient’s local time is n
required.

Voice encoding
To exchange messages between CallPilot and a VPIM-compatible system,
G.726 voice encoding is used.
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VPIM Version 2 conformance
To claim conformance and be recognized as VPIM-compliant, a messaging
system must implement all mandatory features in the areas of content and 
transport. In addition, systems that conform to this profile must not send 
messages with features beyond this profile unless explicit per-destination 
configuration of these enhanced features is provided.

For a listing of VPIM features with which VPIM Networking complies, see th
following table.
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VPIM Version 2 conformance table

Introduction
VPIM Networking conforms to the VPIM Version 2 specifications establishe
by the Internet Engineering Task Force (IETF). The conformance table that
follows indicates what functionality a messaging system must support to be
considered VPIM-compliant. This table also indicates CallPilot support for th
requirements.

Conformance table description
The conformance table has the following columns:

■ Feature: Name of the protocol feature.

■ Area: Conformance area to which each feature applies.

● C = content

● T = transport

● N = notification

■ Status: Whether the feature is mandatory, optional, or prohibited. Five 
degrees of status are used in this table:

● Must = mandatory

● Should = encouraged optional

● May = optional

● Should not = discouraged optional

● Must not = prohibited

■ Nortel: CallPilot VPIM Networking compliance with the feature is marke
with an X. Features ignored when messages are received are marked 
an I.
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Conformance table

Feature Area Must
Shoul
d May

Shoul
d not

Must 
not Nortel

Message addressing formats

Use DNS host names C X X

Use only numbers in mailbox 
IDs

C X X

Use alphanumeric mailbox 
IDs

C X

Support of 
postmaster@domain

C X X

Support of non-mail-
user@domain

C X X

Support of distribution lists C X

Message header fields: Encoding outbound messages

From C X X

From: addition of text name C X X

To C X X

CC C X

Date C X X

Sender C X

Return-path C X

Message ID C X X

Reply to C X
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Received C X X

MIME Version 1.0 (Voice 
2.0)

C X X

Content-type C X X

Content-transfer encoding C X X

Sensitivity C X X

Importance C X X

Subject C X X

Disposition-notification-to N X

Other headers C X X

Message header fields: Detection and decoding inbound messages

From C X X

From: utilize text personal 
name

C X X

To C X X

CC C X I

Date C X X

Date: conversion of date to 
local time

C X

Sender C X I

Return-path C X I

Message ID C X X

Feature Area Must
Shoul
d May

Shoul
d not

Must 
not Nortel
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Reply to C X X

Received C X I

MIME Version 1.0 (Voice 
2.0)

C X I

Content type C X X

Content-transfer encoding C X X

Sensitivity C X X

Importance C X X

Subject C X X

Disposition-notification-to N X

Other headers C X I

Message content encoding: Encoding outbound audio/fax contents

7bit MIME C X

8bit MIME C X

Quoted printable C X

Base64 C X X

Binary C X

Message content encoding: Detection and decoding inbound messages

7bit MIME C X X

8bit MIME C X X

Quoted printable C X X

Base64 C X X

Feature Area Must
Shoul
d May

Shoul
d not

Must 
not Nortel
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Binary C X X

Message content types: Inclusion in inbound messages

Multipart/voice message C X X

Message/RFC822 C X X

Application/directory C X X

Application/directory: 
include TEL, EMAIL

C X X

Application/directory: 
include N, ROLE, SOUND, 
REV

C X X

Application/directory: only 
one per level

C X X

Audio/32KADPCM C X X

Audio/32KADPCM: content-
description

C X X

Audio/32KADPCM: content-
disposition

C X X

Audio/32KADPCM: content-
duration

C X X

Audio/32KADPCM: content-
language

C X

Audio/* (other encodings) C X X

Image/TIFF C X

Multipart/mixed C X X

Feature Area Must
Shoul
d May

Shoul
d not

Must 
not Nortel
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Text/plain C X X

Multipart/report N X X

Multipart/report: human-
readable part is voice

N X

Message/delivery status N X X

Message/disposition-
notification

N X

Other contents C X X

Message content types: Detection and decoding in inbound messages

Multipart/voice message C X X

Message/RFC822 C X X

Application/directory C X X

Application/directory: 
recognize TEL, EMAIL

C X X

Application/directory: 
recognize N, ROLE, 
SOUND, REV

C X X

Audio/32KADPCM C X X

Audio/32KADPCM: content 
description

C X I

Audio/32KADPCM: content 
disposition

C X X

Audio/32KADPCM: content 
duration

C X X

Feature Area Must
Shoul
d May

Shoul
d not

Must 
not Nortel
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Audio/32KADPCM: content 
language

C X I

Image/TIFF C X X

Image/TIFF: send NDN if 
unable to render

C X X

Audio/* (other encodings) C X X

Multipart/mixed C X X

Text/plain C X X

Text/plain: send NDN if 
unable to render

C X X

Multipart/report N X X

Multipart/report: human-
readable part is voice

N X X

Message/delivery status N X X

Message/disposition-
notification

N X

Other contents C X X

Other contents: send NDN if 
unable to render

N X X

Forwarded messages: use 
message/RFC822 construct

C X X

Forwarded messages: 
simulate headers if none 
available

C X X

Feature Area Must
Shoul
d May

Shoul
d not

Must 
not Nortel
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Reply messages: send to 
reply-to, else From address

C X X

Reply messages: always send 
error on non-delivery

C X X

Notifications: use multipart/
report format

N X

Notifications: always send 
error on non-delivery

C X

Message transport protocol: ESMTP commands

HELO T X X

MAIL FROM T X X

MAIL FROM: support null 
address

T X X

RCP To T X X

DATA T X X

TURN T X X

QUIT T X X

RSET T X X

VRFY T

EHLO X X

BDAT (5) T X

Message transport protocol: ESMTP keywords and parameters

PIPELINING T X

Feature Area Must
Shoul
d May

Shoul
d not

Must 
not Nortel
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SIZE T X X

CHUNKING T X

BINARYMIME T X X

NOTIFY N X X

ENHANCED 
STATUSCODES

N X

RET N X X

ENVID N X X

Message transport protocol: 
ESMTP-SMTP downgrading

Send delivery report upon 
downgrade

Directory address resolution

Provide facility to resolve 
addresses

C X X

Use Vcards to populate local 
directory

C X X

Use headers to populate 
local directory

C X X

Management protocols

Network management T X

Feature Area Must
Shoul
d May

Shoul
d not

Must 
not Nortel
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Numerics
120-Minute Messages� 74

A
access code, ESN� 176
access to OM reports� 257
Acknowledgment Tag� 73
adding and configuring a remote site� 192� 272

information required� 192
main steps� 192

adding VPIM open shortcuts� 145
Administrator-Recorded Personal Verification�

73
AMIS Networking, compared with VPIM 

Networking� 80
application gateway

definition� 107
overview� 106

as-required maintenance tasks� 248

B
backing up VPIM Networking� 243

backup schedule� 243
CallPilot backup� 244
switch backup� 244
types of backup� 243

benefits, VPIM Networking� 71

C
Call Sender� 72
CallPilot

and VPIM Networking� 56
backup� 244
configuring� 138
features and VPIM Networking� 72
networking solutions compared� 79

CDP dialing plan, configuration overview� 179
CDP information

configuring� 181
remote prime switch location� 211

CDP steering code
overlap� 180
overview� 180

CDP tab
Prime Switch Location Properties dialog box�

170
Remote Prime Switch Location Properties 

dialog box� 202
Remote Satellite Switch Location Properties

dialog box� 218
clearing disk full condition� 261
compliance with RFC� 102
compose prefix� 142
configuration

DNS server� 139
local satellite switch location� 188
NMS local site� 188
printing information� 252
SMTP/VPIM network shortcuts� 183
VPIM information� 186

configuring
CallPilot, main steps� 138
CDP information� 181
CDP information for a remote prime switch 

location� 212
ESN information� 177
if other networking solutions are 

implemented� 156
local prime switch location, overview� 168
local server, overview� 162
local site, overview� 160
message delivery parameters� 147
non-CallPilot system as a remote site� 227
remote messaging server� 194� 200
remote satellite switch location� 217� 220
remote switch location, overview� 202

connecting to Internet� 84
connecting to intranet� 85
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connecting to other systems� 77
Connections tab, Remote Messaging Server 

Properties dialog box� 199
connectivity test

evaluating results� 238
procedure� 238
purpose� 236

Coordinated Dialing Plan. See CDP dialing plan

D
data network

and VPIM Networking� 56
impact on VPIM Networking limitations� 117
information required about� 123
possible setups� 57
setup overview� 84
setup to connect to Internet� 84
setup to connect to intranet� 85
setup to implement VPIM Networking� 111

data network administrator
definition� 58
importance of working with� 57

definition
application gateway� 107
data network administrator� 58
encryption� 108
firewall� 105
integrated� 57
integrated site� 64
Internet� 59
intranet� 59
IP� 93
messaging network diagram� 131
messaging network spreadsheet� 131
MIME� 100
open� 57
open site� 64
proxy server� 106
TCP� 93
TCP/IP� 93
VPIM� 100
VPIM Networking� 56

deleting
in multi-administrator environment� 279

remote messaging server� 278
remote site� 273� 278
satellite switch location� 278� 280
several remote sites� 280

delivery status notification (DSN)� 75
desktop users

compared with telephone users� 62
exchanging messages with open sites� 66
VPIM compose prefix� 143

dialing plan
and VPIM Networking� 127
CDP for remote prime switch location� 211
CDP information� 179
ESN for remote prime switch location� 208
ESN information� 175
information for remote prime switch location�

205
information required to configure switch 

location� 171
local prime switch location� 171
mailbox addressing follows� 172
mailbox addressing follows for remote prime

switch location� 205
modifying� 276� 282
remote satellite switch location� 219
used to dial a remote switch location� 205

disabling VPIM Networking� 141� 262
disk full condition� 261
DNS

and MX records in implementation� 112
overview� 95

DNS lookup tables� 96
DNS MX record lookup, incoming messages�

88
DNS server� 96

and MX records� 96
configuring� 139
coordinating with ISP� 139
implementation� 112
setup� 98

domain name� 95
domain name system. See DNS
DSN (delivery status notification)� 75
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E
Economy Tag� 73
Electronic Switched Network. See ESN
e-mail gateway server, implementation with�

113
enabling VPIM Networking� 141� 163� 262
encoding VPIM message parts� 61
encryption

definition� 108
Meridian Mail Net Gateway consideration�

108
Enterprise Location ID

local prime switch location� 171
remote prime switch location� 204

Enterprise Networking
compared with VPIM Networking� 79
Enterprise Location ID� 171� 204
Enterprise Site ID� 165
Names Across the Network� 164
receiving message text information� 165
sending message text information to a remote 

site� 198
Enterprise Site ID

description� 165
modifying� 276

Entrust, encryption� 108
error code range� 288
ESN

access code� 176
location code� 176
location code overlap� 176

ESN dialing plan, configuration overview� 175
ESN information, remote prime switch location�

208
ESN tab

Prime Switch Location Properties dialog box�

169
Remote Prime Switch Location Properties 

dialog box� 202
Remote Satellite Switch Location Properties 

dialog box� 218
exchanging messages

over the Internet� 69
with integrated sites, telephone and desktop 

users compared� 67

with open and integrated sites� 64
with open sites� 57
with open sites, telephone and desktop use

compared� 65

F
Failed Networking Sessions alert� 256
Find key, using to locate item� 274
finding a remote site� 274
firewall

and implementation� 113
definition� 105
overview� 105

FQDN
of local server� 165
outgoing SMTP/mail proxy server� 144
overview� 95
right-hand side of VPIM address� 67

free-form non-delivery notification� 75
From entry, header� 67
fully qualified domain name. See FQDN

G
gathering information

purpose� 122
to implement VPIM Networking� 122

General tab
Prime Switch Location Properties dialog box�

169
Remote Messaging Server Properties dialog

box� 195
Remote Prime Switch Location Properties 

dialog box� 203� 218
Remote Switch Location Properties dialog 

box� 202

H
hardware problems� 288
header, From entry� 67
host name� 95
how to
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add a VPIM open shortcut� 267
configure a local satellite switch location�

188
configure a remote messaging server� 200
configure a remote prime switch location�

207
configure a remote satellite switch location�

220
configure CDP information� 181
configure CDP information for a remote 

prime switch location� 212
configure ESN information� 177
configure ESN information for remote prime 

switch location� 209
configure the local messaging server� 166
configure VPIM information� 186
configure VPIM information for remote 

prime switch location� 215
configure VPIM Networking parameters� 148
delete a remote site� 279
delete a satellite switch location� 280
delete a VPIM open shortcut� 268
delete several remote sites� 280
determine the server FQDN� 124
import a spoken name� 226
locate an item using Find� 274
modify a VPIM open shortcut� 267
modify dialing plan information� 282
modify local site configuration� 270
modify remote site configuration� 276
print configuration information� 253
record a spoken name� 223

how VPIM Networking works, overview� 60

I
IMAP. See Internet Mail Access Protocol 

(IMAP)
implementation

DNS and MX records� 112
preliminary requirements� 110
scenarios� 110
to work with open sites only� 170
with DNS server� 112
with e-mail gateway server� 113

with firewall� 113
importing a spoken name� 225� 226
inbound message

from implicit open site� 89
from integrated sites� 88
from unknown open site� 90

incoming message from Internet� 88
left-hand side resolution� 88

incoming messages� 87
incoming messages from Internet, DNS MX 

record lookup� 88
incoming messages from intranet� 87
Incoming SMTP/VPIM box, impact on IMAP�

142
information

gathering to implement VPIM Networking�
122

required about data network� 123
required from remote sites� 130
required from switch� 126
required from switch, checklist� 128
required from switch, methods to gather� 126

Integrated AMIS Networking
configuring a remote prime switch location�

207
configuring ESN information for remote 

prime switch location� 209
integrated site, definition� 64
integrated, definition� 57
Internet

connecting to� 84
definition� 59
special consideration for messages sent ove�

69
Internet Mail Access Protocol (IMAP)

already configured� 114
impact of disabling Incoming SMTP/VPIM 

box� 142
implementation order� 111

Internet Service Provider (ISP)� 139
intranet

connecting to� 85
definition� 59

IP address� 94
IP, definition� 93
ISP, working with� 139
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L
LAN load� 116
left-hand side of VPIM address� 60
left-hand side resolution, incoming messages 

from Internet� 88
local messaging server name� 160
local prime switch location

configuration if NMS local site� 168
configuration if other networking solution 

implemented� 168
configuration overview� 168
description� 170
dialing plan information� 171
Enterprise Location ID� 171
mailbox prefix� 172
name� 170
Prime Switch Location Properties dialog box�

169
recording spoken name� 171

local satellite switch location, configuring� 188
local server

configuration if another networking solution 
implemented� 161

configuration overview� 162
configuration process� 166
FQDN� 165
name� 163
server type� 163

local site
configuring� 160
modifying configuration� 269

local site name� 160� 163
locating remote site� 274
location code

ESN� 176
overlap� 176

loopback test
evaluating results� 241
procedure� 240
purpose� 236

M
mail exchange records. See MX records

mail proxy server FQDN, determining� 125
mail servers, and MX records� 97
mailbox addressing follows dialing plan, local 

prime switch location� 172
mailbox addressing, dialing plan follows for 

remote prime switch location� 205
mailbox prefix

local prime switch location� 172
remote prime switch location� 206

maintenance
as-required tasks� 248
backups following� 249
overview� 248
regularly scheduled tasks� 248

MDN (message delivery notification)� 75
memory full, clearing disk full condition� 261
Meridian Mail

configuring as remote site� 229
connecting to� 77
remote site� 229

Meridian Mail Net Gateway
configuring as remote site� 229
connecting to� 77
encryption consideration� 108
remote site� 229
restrictions on use� 78

message
contents� 61
encoding� 61
encryption� 108

Message Delivery Configuration dialog box, 
SMTP/VPIM tab� 141

message delivery notification (MDN)� 75
message delivery parameters

configuring� 147
overview� 141

message delivery times� 117
message header contents� 62
message media support, networking solutions

compared� 79
Message Subject (Text)� 74
message transfer protocol, modifying� 276
message treatment� 87

inbound from implicit open site� 89
inbound from integrated site� 88
inbound from unknown site� 90
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incoming� 87
incoming from Internet� 88
incoming from intranet� 87

messages
not delivered� 291
receiving VPIM Networking� 69
sent while system disabled� 263

messaging network� 154
Messaging Network Configuration tree view, 

adding sites� 154
messaging network diagram, definition� 131
messaging network representation� 131

benefits� 132
diagram� 131
security� 132
spreadsheet� 131
using to add and configure a remote site� 193

MIME� 56
definition� 100
overview� 100
TCP/IP protocol� 99

modifying
configuration of local site� 269
configuration of VPIM Networking� 260
dialing plan� 276� 282
Enterprise Site ID� 276
message transfer protocol� 276
remote site� 272

modifying remote site� 272
configuration� 275
impact� 273� 275
preliminary requirement� 272

multi-administrator environment, deleting items 
from tree view� 279

multimedia messages, and non-delivery 
notifications� 75

Multiple Recipients� 72
Multipurpose Internet Mail Extensions. See 

MIME
MX records

and DNS in implementation� 112
and DNS server� 96
and mail servers� 97
preference number� 113

N
name

local prime switch location� 170
local server� 163
local site� 160
remote prime switch location� 203
remote site� 195

Name Addressing� 72
Names Across the Network� 72� 164
NDN. See non-delivery notification
network database, impact of modifying remote

sites on� 273
network history

contents� 250
overview� 250

Network Message Service. See NMS
network protocol used with a remote site� 199
Networking Activity report� 256
networking solutions

configuration if implemented� 156
features compared� 79

NMS� 168� 188
NMS local site

configuration required� 188
configuring local prime switch location� 168

NMS site
spoken name imported for� 225
spoken name recorded for� 222

non-CallPilot remote sites
Meridian Mail� 229
Norstar Voice Mail� 231
VPIM-compliant third-party systems� 232

non-CallPilot system
remote sites� 227
server type� 228

non-delivery notification� 69� 74
free-form� 75
multimedia messages� 75

Norstar Voice Mail
configuring as remote site� 231
connecting to� 77
remote site� 231

Nortel Networks, and VPIM profile� 101
not delivered messages, determining cause� 291
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ox
O
OM reports. See Operational Measurement 

reports
Open Networking Activity report� 256
open site

definition� 64
exchanging messages with� 57
restricting messages to� 164

open, definition� 57
Operational Measurement reports� 76

restricted access� 257
outgoing SMTP/mail proxy server FQDN� 144

determining� 125
overlap

CDP steering code� 180
ESN location code� 176
SMTP/VPIM network shortcut� 185

P
packet filter, overview� 106
Personal Distribution Lists� 72
planning and engineering considerations� 116

LAN load� 116
message delivery times� 117
throughput� 116
VPIM Networking limitations� 117

prefix, mailbox� 172
preliminary requirements for implementing 

VPIM Networking� 110
Prime Switch Location Properties dialog box�

169
CDP tab� 170
configuring VPIM tab� 183
ESN tab� 169
General tab� 169
SMTP/VPIM tab� 170

printing configuration information� 252
Private Tag� 73
protocols

TCP/IP protocols� 99
used with a remote site� 199

proxy server
definition� 106

overview� 106

R
Received Time Announced� 73
receiving message text information� 165
receiving VPIM Networking messages� 69
Recipient’s Name (Text)� 74
recording a spoken name� 223
regularly scheduled maintenance tasks� 248
remote messaging server

configuration if another messaging solution i
implemented� 194

configuration overview� 194
deleting� 278
name� 195
network protocol used� 199
sending local user information to� 197
sending message text information� 198
sending messages to a remote site� 196
server FQDN� 198
server types supported� 196

Remote Messaging Server Properties dialog b
Connections tab� 199
General tab� 195

remote prime switch location
CDP information� 211
configuring� 207� 215
configuring ESN information� 209
dialing plan for dialing to this location� 205
dialing plan information� 205
Enterprise Location ID� 204
ESN information� 208
mailbox addressing follows dialing plan� 205
mailbox prefix� 206
name� 203
spoken name recorded� 204

Remote Prime Switch Location Properties 
dialog box

CDP tab� 202
ESN tab� 202
General tab� 203
SMTP/VPIM tab� 203
tabs� 202

remote satellite switch location
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configuration overview� 217
configuring� 220
dialing plan� 219
SMTP/VPIM network shortcuts� 214
spoken name recorded� 219

Remote Satellite Switch Location Properties 
dialog box

CDP tab� 218
ESN tab� 218
General tab� 218
tabs� 218
VPIM tab� 219

remote site
adding� 272
adding and configuring� 192
adding, modifying, and deleting� 272
deleting� 273� 278
how to delete� 279
how to modify configuration� 276
if other networking solutions implemented�

156
impact of modification� 275
information required from� 130
information required to add and configure�

192
locating� 274
main steps to add and configure� 192
modifying� 272
modifying configuration� 275
name� 195
non-CallPilot� 227
non-CallPilot systems� 227� 229� 231� 232
server FQDN required� 123
using network representation to add and 

configure� 193
VPIM-compliant third-party system� 232

Remote Site Spoken Names� 73
remote switch location

configuration overview� 202
spoken name� 222� 225

Remote Switch Location Properties dialog box, 
General tab� 202

Reply All� 72
Reply features, interaction with VPIM 

Networking� 90
Reply To� 72

Request for Comments. See RFCs
restricting

message exchange� 164
messages to open sites� 164
sending messages to a remote site� 196

RFCs
VPIM� 101
VPIM Networking compliance� 102

right-hand side of VPIM address� 61
routing, TCP/IP� 94

S
satellite switch location

deleting� 278
SMTP/VPIM network shortcuts� 219

scheduling backups� 243
security

application gateway� 106
firewalls� 105
overview� 104
packet filter� 106
proxy server� 106
using existing security features� 104

Sender’s Department� 74
Sender’s Name (Text)� 74
sending local user information to a remote site�

197
sending message text information to a remote

site� 198
sending messages to other sites� 163
Sent Time Announced� 74
server FQDN� 165

determining� 124
relationship to VPIM shortcuts� 88
remote site� 198
required for integrated remote sites� 123

server type
local server� 163
non-CallPilot remote sites� 228
supported for remote messaging server� 196

setting up DNS server� 98
Shared Distribution Lists� 72
shortcuts

VPIM Networking� 183
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VPIM open� 144
VPIM open andSMTP/ VPIM network 

compared� 67
Simple Message Transfer Protocol. See SMTP
SMTP� 56

overview� 99
TCP/IP protocol� 99

SMTP/VPIM network shortcut
compared with VPIM open shortcut� 67
configuring� 183
length� 185
overlap� 185
relationship to PSTN� 184
remote satellite switch location� 214� 219

SMTP/VPIM tab
Prime Switch Location Properties dialog box�

170
Remote Prime Switch Location Properties 

dialog box� 203
SMTP/VPIM tab, Message Delivery 

Configuration dialog box� 141
spoken name

for remote switch location� 222� 225
importing� 225� 226
importing for local NMS site� 225
recorded for remote satellite switch location�

219
recording� 223
recording for local NMS site� 222
recording for local prime switch location� 171
recording overview� 222
remote prime switch location� 204
ways to add� 205

steering code for CDP� 180
switch

backup� 244
checklist of required information� 128
configuration changes� 282
information required from� 126
methods to gather information� 126

T
TCP, definition� 93
TCP/IP

definition� 93
overview� 93
protocols� 99
routing� 94
troubleshooting network� 289

TCP/IP protocols
MIME� 99
SMTP� 99

telephone users
compared with desktop users� 62
exchanging messages with open sites� 65
VPIM compose prefix� 143

telnet test
evaluating result� 242
procedure� 242
purpose� 236

terms used in this guide� 57
test suite

connectivity test� 236
loopback test� 236
purpose� 236
telnet test� 236

testing VPIM compliance of third-party 
systems� 236

text information in messages� 165
third-party systems

connecting to� 77
determining VPIM compliance� 77
restrictions� 78

third-party systems, testing compliance� 236
throughput� 116
TIFF format� 61
Timed Delivery� 74
Transport Control Protocol/Internet Protocol. 

See TCP/IP
tree view, deleting items from� 278
troubleshooting

basic problems� 288
overview� 286
TCP/IP network� 289

U
unsuccessful delivery of VPIM Networking 

message� 69
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Urgent Tag� 73
User’s Actual Personal Verification� 73

V
voice encoding� 297
Voice Profile for Internet Mail. See VPIM
VPIM

definition� 100
RFCs� 101
role of Nortel Networks in development of�

101
VPIM address

compared with e-mail address� 60
example� 60
left-hand side� 60
parts� 60
restrictions� 60
right-hand side� 61

VPIM compliance
of third-party systems� 77
overview� 296

VPIM compose prefix� 142
desktop users� 143
telephone users� 143
when not required� 143

VPIM message
contents� 61
encoding of parts� 61
header� 62

VPIM Networking
and CallPilot� 56
and CallPilot features� 72
and dialing plans� 127
benefits� 71
compared with AMIS Networking� 80
compared with Enterprise Networking� 79
configuring a remote messaging server� 200
configuring a remote satellite switch location�

220
configuring CDP information� 181
configuring CDP information for remote 

prime switch location� 212
configuring local satellite switch location�

188

configuring parameters� 148
configuring the local server� 166
configuring VPIM information� 183� 186
connectivity� 77
definition� 56
desktop and telephone users� 62
disabling� 141� 262
enabling� 141� 262
encryption� 108
gathering information� 122
implementation scenarios� 110
interaction with Reply features� 90
intranets and the Internet� 59
local site configuration� 160
maintaining� 248
message delivery notification� 75
message treatment� 87
modifying configuration� 260
performing backups� 243
planning and engineering considerations� 116
preliminary requirements for configuration�

154
protocols used� 99
receiving messages� 69
relationship to data network� 56
security overview� 104
TCP/IP� 93
telnet test� 236
uses SMTP and MIME� 56
VPIM compliance� 102

VPIM Networking test suite� 236
connectivity test� 236
loopback test� 236

VPIM Networking, server FQDN of remote site�

198
VPIM open shortcuts� 144

adding� 266
adding sites to list of� 145
compared with SMTP/VPIM network 

shortcut� 67
deleting� 266
modifying� 266
relationship to server FQDN� 88
restrictions� 145
when to add� 266

VPIM tab
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configuring� 183
Remote Satellite Switch Location Properties 

dialog box� 219
VPIM Version 2

conformance� 297
conformance table� 298
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A
Add/Update Remote Users on this Server� 164

C
CDP Steering Code� 211

Overlap� 180
Prime Switch Location Properties dialog box�

180
Remote Prime and Satellite Switch Location 

Properties dialog boxes� 211
Connection DNs� 200

D
Description

Local Messaging Server Properties dialog 
box� 163

Prime Switch Location Properties dialog box�

170
Remote Messaging Server Properties dialog 

box� 196
Remote Prime and Satellite Switch Location 

Properties dialog boxes� 204
Dialing plans for dialing to this location

Prime Switch Location Properties dialog box�

171
Remote Prime and Satellite Switch Location 

Properties dialog boxes� 205

E
Enterprise Initiating Password� 200
Enterprise Location ID

Prime Switch Location Properties dialog box�

171

Remote Prime and Satellite Switch Location
Properties dialog boxes� 204

Enterprise Responding Password� 200
Enterprise Site ID� 165

Local Messaging Server Properties dialog 
box� 165

Remote Messaging Server Properties dialog
box� 198

ESN Access Code used by this location
Prime Switch Location Properties dialog 

boxes� 176
Remote Prime and Satellite Switch Location

Properties dialog boxes� 208
ESN Location Code

Overlap� 176
Prime Switch Location Properties dialog box�

176
Remote Prime and Satellite Switch Location

Properties dialog box� 208
Remote Prime and Satellite Switch Location

Properties dialog boxes� 208

I
Incoming SMTP/VPIM� 141

L
Local Messaging Server Properties dialog box

Add/Update Remote Users on this Server�

164
Description� 163
Enterprise Site ID� 165
Name� 163
Receive Message Text Info� 165
Send Messages to all other Servers� 163
Server FQDN� 165
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ox
Server type� 163

M
Mailbox addressing follows dialing plan

Prime Switch Location Properties dialog box�

172
Remote Prime and Satellite Switch Location 

Properties dialog boxes� 205
Mailbox prefixes

Prime Switch Location Properties dialog box�

172
Remote Prime and Satellite Switch Location 

Properties dialog boxes� 206
Message Delivery Configuration dialog box

Incoming SMTP/VPIM� 141
Outgoing SMTP Mail/Proxy Server� 144
Outgoing SMTP/VPIM� 141
VPIM Compose Prefix� 142
VPIM Open Shortcuts� 144

N
Name

Local Messaging Server Properties dialog 
box� 163

Prime Switch Location Properties dialog box�

170
Remote Messaging Server Properties dialog 

box� 195
Remote Prime and Satellite Switch Location 

Properties dialog boxes� 203
Network protocol� 199

O
Outgoing SMTP Mail/Proxy Server� 144
Outgoing SMTP/VPIM� 141
Overlap

CDP Steering Code� 180

ESN Location Code� 176
SMTP/VPIM Network Shortcuts� 185

P
Prime Switch Location Properties dialog box

CDP Steering Code� 180
CDP Steering Code Overlap� 180
Description� 170
Dialing plans for dialing to this location� 171
Enterprise Location ID� 171
ESN Access Code used by this location� 176
ESN Location Code� 176
ESN Location Code Overlap� 176
Mailbox addressing follows dialing plan� 172
Mailbox prefixes� 172
Name� 170
SMTP/VPIM Network Shortcuts� 183
Spoken Name Recorded� 171

R
Receive Message Text Info� 165
Remote Messaging Server Properties dialog b

Description� 196
Enterprise Site ID� 198
Name� 195
Network protocol� 199
Send local user information to this Server�

197
Send Message Text Info to this Server� 198
Send Messages to this Server� 196
Server FQDN� 198
Server type� 196

Remote Prime and Satellite Switch Location 
Properties dialog boxes� 211

CDP Steering Code� 211
Description� 204
Dialing plans for dialing to this location� 205
Enterprise Location ID� 204
ESN Access Code used by this location� 208
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ESN Location Code� 208
ESN Location Code Overlap� 208
ESN Location Codes� 208
Mailbox addressing follows dialing plan� 205
Mailbox prefixes� 206
Name� 203

Remote Prime Switch Location Properties 
dialog box

See also Remote and Satellite Switch 
Location Properties dialog boxes

Spoken Name Recorded� 204
VPIM Network Shortcuts� 214
VPIM Prefix� 214
VPIM Prefix Overlap� 214

Remote Satellite Switch Location Properties 
dialog box

See also Remote Prime and Satellite Switch 
Location Properties dialog boxes

SMTP/VPIM Network Shortcuts� 219
Spoken Name Recorded� 219

S
Send local user information to this Server� 197
Send Message Text Info to this Server� 198
Send Messages to all other Servers� 163
Send Messages to this Server� 196
Server FQDN� 165

Local Messaging Server Properties dialog 
box� 165

Remote Messaging Server Properties dialog 
box� 198

Server type
Local Messaging Server Properties dialog 

box� 163
Remote Messaging Server Properties dialog 

box� 196
SMTP/VPIM Network Shortcuts� 183

Local Prime Switch Location Properties 
dialog box� 185

Remote Satellite Switch Location Properties 
dialog box� 219

Spoken Name Recorded
Prime Switch Location Properties dialog box�

171
Remote Prime Switch Location Properties 

dialog box� 204
Remote Satellite Switch Location Properties

dialog box� 219

V
VPIM Compose Prefix� 142
VPIM Network Shortcuts

Remote Prime Switch Location Properties 
dialog box� 214

VPIM Open Shortcuts� 144
VPIM Prefix

Prime Switch Location Properties dialog box�

184
Remote Prime Switch Location Properties 

dialog box� 214
VPIM Prefix Overlap

Prime Switch Location Properties dialog box�

184
Remote Prime Switch Location Properties 

dialog box� 214
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